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Introduction
Small, simple and affordable, MadgeTech data loggers can measure and 
record data at specified intervals. MadgeTech’s Data Recording Software 
requires no programming skills, and enables the user to effortlessly select 
reading rate, specify the user’s ID, and initiate the start of data collection. For 
immediate use of the data logger refer to the Quick Start Guide on page 14.

In addition, all data can be saved in a format easily read by spreadsheet 
applications such as “Microsoft Excel®” or “Lotus 1-2-3®”. It is our goal to 
bring you accurate, low-cost, easy-to-use data loggers that integrate easily 
into the user’s working environment. To better understand your needs and to 
better serve you, we welcome and appreciate your feedback.

Thank you for choosing MadgeTech for your data logging requirements.

Warranty
Products manufactured by MadgeTech, Inc., are warranted against defective 
material and workmanship for a period of one year, starting from the date 
of shipment. In the event that a MadgeTech product is found to be defec-
tive, MadgeTech will repair or replace the product at its sole discretion. Such 
repair or replacement shall be the sole remedy of this warranty.

This warranty extends only to the original purchasing customer and does 
not apply to any unit, which in our sole judgment, has been subjected to:

 a) Operating or environmental conditions in excess of our written 
specifications or recommendations;

 b) Customer damage, misuse or neglect;

 c) Improper installation, repair or alteration.

This warranty excludes batteries.
Except as to title, this is our only warranty for the products. MadgeTech, 

Inc. expressly disclaims all other warranties, guarantees or remedies—wheth-
er expressed or implied or statutory—including any implied warranty of mer-
chantability or fitness for a particular purpose. We also disclaim any implied 
warranty arising out of trade usage or out of a course dealing or course of 
performance. We do not guarantee the integrity of data or warranty that the 
products will operate uninterrupted or error-free.

MadgeTech data loggers and their associated software have been thor-
oughly tested and the documentation reviewed. However, MadgeTech does 
not warrant the performance of its products, or that the products or their 
associated software will operate as described in this manual.

Please see page 145 for a more descriptive explanation of our warranty. 
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Battery Warning
Most MadgeTech data loggers contain a lithium battery. Do not cut the 
battery open, incinerate, or recharge. Do not heat lithium batteries above 
the specified operating temperature.* Dispose of the battery in  
accordance with local regulations.

*See the individual specification sheets at www.madgetech.com.

Battery Replacement
Most MadgeTech miniature data loggers contain a user-replaceable 3.6 volt 
or 3.0 volt lithium battery. Replacement batteries may be purchased from 
the factory along with installation instructions. Before attempting to replace 
a battery, refer to published specification sheets at http://www.madgetech.
com select (1) Products. Then click the link for the specific data logger to 
ensure the device has a user-replaceable battery. If the device does not have 
a user-replaceable battery, or the customer simply does not wish to replace 
the battery themselves, the device may be returned to the factory for service. 
In this case, the customer should contact the company from which the unit 
was purchased for an Return Merchandise Authorization (RMA) number and 
return the product as instructed by customer service. MadgeTech will replace 
the battery and return the data logger promptly.
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Hardware
Package Inspection

Verify that the data logger(s) was not damaged in transit by carefully unpack-
ing all items in the shipping carton and looking for obvious signs of physical 
damage. If the data logger is damaged, repack it in its original container and 
contact MadgeTech Customer Service at 603-456-2011. Any damage noted 
upon receipt must be documented to file a claim against the carrier.

System Requirements

MadgeTech Data Recording software requires an IBM or compatible PC with 
the following: 

•- Pentium or higher processor

•  Windows 95/98/2000/XP/NT/VISTA

•  128 MB RAM 

•  Color 800 X 600 monitor 

•  30 MB free disk space

•  3.5” disk drive or CD-ROM

•  Available 9 pin male serial (COM) port or USB port

NOTE: Although the software is designed to work with the Windows operat-
ing systems listed above, MadgeTech cannot guarantee operation on OS’s no 
longer supported by Microsoft Support Life Cycle Policy.
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Software Installation

Installing from CD ROM

Insert the CD ROM labeled MadgeTech Data Recording Software into the 
host computer’s CD ROM drive. If the CD does not run automatically, from 
the Windows Start Menu, choose the Run command and type d:\autorun.
exe into the Open field and click OK, it will bring the installation menu win-
dow MadgeTech CD Contents as shown below. 

If the host computer’s CD ROM Drive is not the D: drive, use the correct let-
ter for the instructions above. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click MadgeTech Software to Install Madgetech Software Page.
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Install MadgeTech Software

The selected language will be displayed on the installation windows.
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The following screens (could possibly show a previous version number) are 
examples of the installation windows.
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“Click Back to MadgeTech CD Contents to MadgeTech CD Contents page.
Click MadgeTech Pocket to Install MadgeTech Pocket Software page:
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Click Back to MadgeTech CD Contents to MadgeTech CD Contents page.
Click Drivers and Third Party Tools to MadgeTech Device Drivers and Third 
Party Tools page:

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Install USB Interface Drivers (for use with IFC200)
The USB interface drivers can be installed when the host computer has USB 
drivers. After the installation the data logger will communicate with the PC 
through USB port. The host computer must have USB drivers to install the 
USB interface drivers.

Select the Install button to install USB interface drivers. 
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Note: A pop up box may appear stating, “This software may impair or desta-
bilize the operation of your system, either immediately or in the future.” Do 
not worry about this message. The drivers have been tested and will not in-
terfere with the operation of the host computer. Select “continue” to proceed 
with the installation.

Click Back to MadgeTech CD Contents to MadgeTech CD Contents page.
Click View Documentation and Resources to Documentation and 
Resources page:

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

View MadgeTech Read Me, View MadgeTech Software Manual and View 
MadgeTech Quick Start Guide are documents about MadgeTech data log-
gers, software, and more. After installation, the software will be listed under 
the default MadgeTech software program group and saved under the default 
C:\Program Files\MadgeTech 2.00.XX\directory. 
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Running the Software 

Getting Started

For simplicity and ease of use all MadgeTech data loggers operate similarly. 
The MadgeTech data logger software automatically configures itself specifi-
cally for each class of logger by reading the device type. Each class of logger 
has a unique device type and identifies itself when queried by the host com-
puter. This has been implemented to minimize confusion and to eliminate 
the need to learn different software packages. Therefore, only one software 
package and only one manual is required for all MadgeTech Data Loggers. In 
certain instances where differences occur, an attempt is made in this man-
ual to bring clarification and avoid confusion. Most examples used in this 
manual are for the Temp101, but can be extended to all devices.

Run the software by selecting the MadgeTech icon in the MadgeTech 
Software program group. The software will open and is immediately ready 
for starting a device or downloading data. The tool bar and menu items will 
appear as shown below. All toolbar commands are also menu 
commands.

Note: Throughout this manual, when a menu command has a corresponding 
toolbar command, the toolbar icon is included with the description of the 
menu command. 
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Quick Start Guide
For immediate use of the data logger, follow these six simple steps:

1. Install the software (see Software Installation page 5, if help is 
needed with this step). 

Attach the logger:

1a. If using the IFC110, attach the logger to the host computer using 
the interface cable, as shown in the diagram on the next page.

1b. If using the IFC200 or IFC300, install the USB drivers first, then at-
tach the logger to the host computer using the interface cable, as 
shown in the diagram on the next page.

2. From the Communication Menu, select Auto Configure Port.

3. From the Device Menu, select Start Device. 

4. Select the Reading Rate to be used. Leave all other settings alone. 

5. Click on Start Device.

After a brief pause while the software communicates with the device, the 
user will see the message Device Started. The device is now running and 
taking measurements. Place it in the elected environment to perform its 
measurements. When the user is ready to view the measurements, simply 
connect it to the computer and select Read Device Data from the Device 
Menu. 

Attaching the Interface Cable

IFC110 Interface Cable for serial 
port (same concept for IFC102, 
IFC 103, IFC200, IFC202, and 
IFC300).

*For data loggers 
featuring a delay 
start, see page 68.
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Interface Cable Installation

1. Fully insert the male connector of the IFC110 interface cable into the 
female receptacle of the data logger. Insert fully the RS232 connector 
into the Serial Port.

2. Fully insert the male connector of the IFC200 interface cable into the 
female receptacle of the data logger. Fully insert the female USB con-
nector into the USB.

Note: Most MadgeTech data loggers can use both IFC110 and IFC200 inter-
face cables. For interface cable data logger clarification contact technical 
support at 603-456-2011 or support@madgetech.com. 
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File Menu

The File Menu will appear as follows:

File Menu: New 

Select this command to create a new graph window. It will not discard any 
information that is already on the screen or in existing windows. Multiple 
windows may be created and displayed simultaneously, and may be manipu-
lated using the Window Menu, page 106.

File Menu: Open 

Select this command to open previously saved data files, loading them into 
the current window. If no windows are open, a new one will be created. 
Data in the current window is not discarded, new data is added as an ad-
ditional dataset. Multiple windows may be created and displayed simultane-
ously, and manipulated using the Window Menu, page 106. 
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Open Dialog Box

Select the Open command for the following window:

There are three types of files that may be opened with this software. These 
file formats are described in Save All (next page).

File Menu: Close

This command closes the currently active window. If the data displayed in 
the window has not been saved, the user will be prompted to save it at this 
time. This command will not discard data from or close any other existing 
windows. 

File Menu: Save 

Saves the dataset currently being shown.

File Menu: Save As

Select Save As from the File Menu to save a copy of data under an alternate 
name, in any of the three file types discussed on the following page.
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File Menu: Save All 

Select Save or Save All from the File Menu to display the window as shown 
below: 

Data may be saved as one of three types of files. These files are as follows:

*.dat 

This is our own internal ASCII data format. This format can be viewed by 
most text editing or word processing software. 

*.txt 

Files stored in this format contain tab delimited text and can be viewed by 
most word processing and spreadsheet programs. 

*.csv 

Files stored in this format contain comma separated values and are directly 
readable by Microsoft Excel® and other spreadsheet programs. 

Note: In order to save a dataset, it must be displayed in the graph or data tab.
Note: To read data in an external program use the Export Data commands.
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File Menu: Save All As

Select Save All As from the File Menu to save all copies of datasets under 
alternate names, in any of the three file types discussed.

Note: The user will be prompted to save each individual dataset as a different 
file. The software does not open/save multiple datasets in a single file; they 
are required to be uploaded individually.

File Menu: Export Data

Select Export Data from the File Menu to export a copy of the data in a 
format that is designed for easy import into programs such as Excel®. Data 
can be read in the same units displayed on the screen. The three file types 
are the same as those provided with the Save command, except data which 
is specific to the software, such as graph colors, is stripped out. Use Export to 
open the file in another program.

File Menu: Example Data

Select the Example Data command from the File Menu to load and display 
sample data. Example data can be given for Temperature, Humidity, Pres-
sure, Voltage, Current, Shock, Level, pH, Bridge, and Wireless Series Data 
Recorders. Simply enter in the part number of a data logger and click O.K.

File Menu: Save Memory Dump

Select Save Memory Dump from the File Menu to download the entire 
memory contents of the attached device and save it in binary format. This 
command is useful to the factory for troubleshooting problems in the field 
and recovering data from a malfunctioning device. The user will typically not 
use this command unless directed to do so by our tech support department. 

File Menu: Page Setup

Select Page Setup from the File Menu to bring up the window on the next 
page. This window allows the user to select the printer and printing options. 
The options will vary according to the particular printer and network. Con-
sult the printer manufacturer for details about the printer’s options.
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File Menu: Load PocketPC Data

Select Load PocketPC Data from the File Menu to load the data saved 
by MadgeTech PocketPC Software running on Windows Mobile Pocket PC 
devices. 

A file selection dialog will appear and display the available XML files for  
selection. Data files saved by MadgeTech PocketPC Software are named with 
the data logger’s serial numer and data collection date and time string and 
are in the XML file format. 

 
Select the file to load and click Open.
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File Menu: Print Summary

Select Print Summary from the File Menu to print the statistics for currently 
selected device.

File Menu: Print Graph 

Select Print Graph from the File Menu to print the currently selected graph 
to the host printer. The single dataset file can be printed by viewing the 
Graph tab. Printing out the composite graph can be achieved through the 
Composite Graph tab.

Print Dialog Box

Select Print Summary or Print Graph from the File Menu to bring up the 
Print Dialog Box: 
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File Menu: Print Data

Select Print Data from the File Menu to print tabular data.  The Data Table 
Report allows the user to customize their tabular data for general or reporting 
purposes. The amount of data will vary depending upon the selected data-
sets and the reading ranges that selected by the user.

Preview Report (See Print Preview)

The window below is the sample of the report preview:
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Single Graph Data File

To make a report for a single file, select the Graph Tab. Select Print Preview 
from the File Menu.  There will be a check mark next to the Print Preview  
option. Select Print Data from the File Menu.  The following form will appear:

      List View (top of the form)

           - The user can select or unselect the channels by clicking the cell of  
 the Status column 
      Report Header
          - The user can change the report title
          - The user can change the font size for the report 
          - The user can setup the report page by clicking the Page Setup button  
            (see Page Setup, page 19).
      Select Channel Title
           - The user can select the channel title by using predefined or customized        
             options
      Report Fields
           - The Minimum, Maximum and Delta values are not available for the 
            single graph report
      Channel Selection
          - The user can select which channels to display
          - The Unit Type and Unit fields are available if the user selects the  
            Select Unit Type option button
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      Preview button
          - Click the Preview button to preview the report of the single graph.

Composite Graph Data File

 
      List View (top of the form)
           - The user can select or unselect the channels by clicking the cell of  
 the Status column. The Setup button will appear if the file is selected.

 Click the Setup button, the Channel list view appears (the channels  
 list of the file will be displayed with a Back button).
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Click the Back button to back to the file list view.
      Report Header
          - The user can change the report title.
          - The user can change the font size for the report.
          - The user can setup the report page by clicking the Page Setup button  
            (see Page Setup, page 19).
      Select File Title
           - The user can select the file title by using predefined or customized        
             options
      File Selection
          - The user can use the Select All Files check box to select all files
          - The unit field is available if the user selects a specific unit type from  
            the Unit Type field
      Report Fields
          - The Minimum, Maximum and Delta are not available if All Units
            is selected as the Unit Type.
      Preview Button
          - Click the Preview button to preview the report of the composite  
            graph.

Print Report

1) Print the report without the preview (uncheck the Print Preview option 
from the File Menu)
Click Print Data and the form Data Table Report appears as below.
Click the Print button and the Print dialog box appears.
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2) Print the report from the preview

Click the Print button on the tool bar of the report preview window (see 
Preview Report page 22)

 File Menu: Print Device Configuration

Select Print Device Configuration from the File Menu to print information 
that relates to the dataset file currently displayed on the screen.

Note: The message unable to print device configuration will inform the user if 
there is no dataset file open.

File Menu: Print Preview

Select Print Preview from the File Menu to place a check mark next to it. 
When this menu item is checked, the result of Print Graph, Print Data, Print 
Summary and Print Device Configuration will display on the screen, rather 
than on the host printer. This allows a preview of the data to be printed. To 
uncheck this menu item select Print Preview again.

File Menu: Exit

Select Exit from the File Menu to close all open files and exit the program. 
There will be a prompt to save all files that have been changed
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Edit Menu
The Edit Menu will appear as follows:

Edit Menu: Cut, Copy & Paste

The Edit Menu toolbar is currently disabled. 
The Cut, Copy and Paste functions are not available for use.

View Menu
The View Menu will appear as shown:

View Menu: Toolbar
The Toolbar option is used to show or hide the toolbar located at the top of 
the screen. Hiding the toolbar allows more room for the graph being dis-
played.

View Menu: Status Bar

The Status Bar option is used to show or hide the status bar located at the 
bottom of the screen. Hiding the status bar allows more room for the graph 
being displayed.
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Select Preferences to display the window shown below.

The following six tabs are found in this window: File, Communications, 
Display, Data, Graph, and Calculations. Each tab provides the ability to set 
preferences for a part of the program.

File Tab
Select the File tab from Preferences Form, to set the default file locations.

Default Log File Location 

The Default Log File Location from the Preferences Form refers to the 
log files that are created while the software is running. Not all data loggers 
create a log file. The software appends a log file for each wireless transmitter 
when it receives a transmission. Through this option the user can change the 
default location where the log files are saved. 
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Default INI File Location 

Select the Default INI File Location from the Preferences Form to refer to 
the initial settings the software will apply when it starts up. For those without 
read/write privileges, the INI File Location can be changed to a public folder 
for multiple users. 

Default Data File Type 

Select the Default File Type to choose from the list of file types in the drop 
down menu . The type can be changed when the file is saved, it is simply 
convenience setting. When checked, the data will be automatically be saved 
to the default file location that was selected in the file tab.

Note: This is limited to the data that was downloaded from the device to the 
computer (see Read Device Data, page 63).

Default Data File Location 

Select the Default Data File Location from the Preferences Form to re-
fer to the folder that the datasets are saved to. When the user Saves a file 
(page 17), the chosen directory will be the default save location. This can be 
changed when the user saves the file, it’s simply a convenience setting.
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Communications Tab
This tab sets various Communications preferences.

Autoconfigure Comm Port 

Check this option to automatically configure the correct COM port in use to 
the host computer’s . Leave this item checked unless the software is having 
trouble identifying the host computer’s COM port (this happens rarely, usu-
ally only on older PCs). If this item is unchecked, the user must configure the 
Comm settings manually. See Select Comm Port, page 45. 

Autoconfigure Baud Rate

Check this option to automatically configure the correct communications 
speed. Leave this item checked unless the software is having trouble identify-
ing the host computer’s COM port (this happens rarely, usually only on older 
PCs). If this item is unchecked, the baud rate must be configured manually. 
See Select Baud Rate, page 45. 
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Accept Wireless Input

Check this option to accept real time readings from the RF series of data log-
gers. To accept these readings the computer must have an RFC101A inter-
face cable connected to an available COM port and the wireless RF logger or 
extender radios must be enabled to transmit. 

Communications Redundancy 

This refers to the number of times the PC will try to communicate with the 
logger. Setting the tab closer to the left will decrease the number of times it 
will try to communicate and setting the tab further to the right will increase 
the number of times it will try to communicate with the logger.

Communications Timeout 

This refers to the length of time the PC will wait for the response from the 
data logger. Setting the tab closer to the left will decrease the amount of 
time the PC waits for a response, while setting the tab further to the right 
will increase the length of time the PC will wait. This setting is used when the 
user is has a device that takes a longer time to respond to the PC.
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Display Tab
The Display Preferences tab sets display time and language settings. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use 24 Hour Time Format

Check this box to use a 24-hour format. Leave it unchecked to use a 12-hour 
format.

Use UTC Standard Time
Check this box to use Universal Coordinated Time (UTC). Formerly known as 
Greenwich Mean Time (GMT). 

Use UTC Abbreviation Time 

Check this box to display the time zone that is relative to UTC time. If both 
the Use UTC Standard Time box and Use UTC Abbreviation Time box are 
unchecked then the system time of the PC will be displayed. 

Select Display Language

Choose the language to be displayed on the software from the language 
drop down list. The software toolbar command also offers the language 
choice.
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Automatically Select Language 

Check the Automatically Select Language box (see screen previous page) 
to choose the restarted software language as the computer system language 
and ignore the selected language. Unchecked the restarted software lan-
guage is always the selected language. 

Data Tab

The Data Preferences tab can set various data preferences. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title Preferences 

The Title Preferences settings determine which items appear in the Title 
of the dataset. If all boxes are unchecked untitled dataset will appear as the 
title name. The Device Type, Device Serial Number, Device ID, Down-
load Date, and Download Time can be selected or unselected . Check the 
Prompt for Title box to prompt for a title each time, rather than generating 
its own title. These features must be enabled prior to downloading the data 
for them to apply. 
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Units Preferences 
The Units Preferences settings determine the units used for the various 
types of measurements. In Select Unit Type, select the type of measurement 
from the dropdown list, then Select Preferred Units to use from the second 
dropdown list. The high point and low point range can be defined on the 
graph. This defines the Preferred Scale. See Set Graph to Preferred Scale, 
page 91.

Clear Unit Preferences 

Select the Clear Unit Preferences button to set all unit preferences to the 
[No Preference] setting.

Automatically update units 

Check the Automatically Update Units option to allow preferred units to 
change when the corresponding units are changed on the screen.

Apply units to all open data

Check the Apply units to all open data option to trigger all corresponding 
units to change datasets on the screen. From this tab the graph preferences 
can be selected.
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Graph Tab
In the Graph Preferences tab the graph preferences can be selected. 

Autoscale Graph 
Check the Autoscale Graph option to automatically optimize the vertical 
scale of the graph to match the minimum and maximum data points shown 
on the graph. This provides maximum resolution for viewing the graph.

Note: The Composite Graph will have the Autoscale Graph option applied if 
there are multiple datasets that have the Autoscale Graph option applied and 
un-applied.

Smart Autoscale 

Check the Smart Autoscale option to round the vertical and horizontal 
scales to a tenth of a decimal point providing a slightly wider scaled range. If 
the option is off then the horizontal and vertical scales will be rounded to the 
thousandth.

Note: The Composite Graph will have the Smart Autoscale option applied if 
there are multiple datasets that have the Smart Autoscale option applied and 
un-applied.
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Buffer Vertical Scale 

Check Buffer Vertical Scale option to add an extra 10 measurements to 
the beginning and end ranges of the vertical scale, making the plotted lines 
centered in the graph. 

Autoscale on Zoom 

Check Autoscale on Zoom option to automatically scale the graph when 
zooming in using the horizontal zoom tool only.

Synchronize Time 

Check Synchronize Time option to view multiple graphs which only affects 
the composite graph tab. When checked, multiple datasets will be shown 
over a scaled period of time through the composite graph. When unchecked 
the multiple datasets will instead overlap each other and the time shown is 
directly related to which graph the cursor has selected.

Synchronize Vertical Scale 

Check Synchronize Vertical Scale option to view multiple graphs which 
only affects the composite graph tab. When checked multiple datasets are 
shown with scaled vertical ranges, meaning each parameter (temperature, 
humidity, etc.) will have one default set range for each parameter. When the 
option is unchecked each plotted graph will have its own individual scaled 
vertical range.

Annotate Graph 

Check Annotate Graph option to permit all annotations be viewed on the 
computer screen, this option is beneficial when printing the annotations. 
When this option in unchecked, the data can still be annotated, yet it is not 
visible on the screen unless that data point has been clicked, whereas the an-
notation appears in the top left hand corner of the graph.

Animate Graph 

Check the Animate Graph option to create blinking maximum and mini-
mum alarm setting lines on the screen.



Data Logger Software

Page 37

Calculations Tab
In the Calculations Preferences tab various calculations preferences can be 
set.

Edit Calculation 

Select the Edit Calculation button, the following window will appear:

F0

Select the F0 button to display the settings for F0, a common unit of 
sterilization. 

PU 

Select the PU button to display the settings for pasteurization units. 
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For more information about calculation units go to www.madgetech.com. 
From the menu bar at the top of the MadgeTech home page, select 
Technical Notes, then select Sterilization and Pasteurization Units Appli-
cation Note.
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Engineering Units (software level)

This is a MadgeTech software feature which allows the customization of 
engineering units. These units are software level units (saved in the software 
specific to user’s PC not the device) and their functions are the same as non-
customized units. 

Note: There are two types of engineering unit levels (software and device). The 
user can manipulate the software level engineering units whenever the soft-
ware is on, but the device level is only available to edit when the connected 
device supports engineering units. See Device Level Engineering Units, page 
53 for details.

View Menu: Engineering Units (software level)

Select Engineering Units from the View Menu (page 27) to display the fol-
lowing window:
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Create Engineering Units by using the Engineering Units Wizard button 
(see screen previous page) or Create a new unit button on bar, below.

Engineering Units Wizard

Select the Engineering Units Wizard button to bring up the Engineering 
Units Wizard window in the following screen. 

The wizard will calculate the engineering unit based on the input.
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Edit Engineering Units

If the box below is enabled, the engineering units can be edited directly. 
Otherwise, choose the Create a new unit button (see previous page) or 
highlight a record from the Engineering Units list to enable this section.

Definition Graph 

The Definition Graph compares Recorder Units and Scaled Engineering 
Units when data is input for the engineering units.
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Recorder Units 

Select a Recorder Unit must be selected based on the type of parameter be-
ing converted. Input the low/high reference values. When no specific unit 
is displayed the Select a Recorder Unit dropdown list (Fig. 1) will contain 
all available units, otherwise, it will only contain the unit that relates to the 
displayed unit (Fig. 2) as shown below.

Fig. 1

Fig. 2
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Scaled Engineering Units 

The Scaled Engineering Units (see screen shot page 41) requests the de-
scription, label, and low/high unit values of the engineering unit.

The description field allows the full name of the parameter to be displayed 
in the software. Examples of this are Volts, Milliamps, pH, Gallons, etc. This 
name is displayed on the graph and data table as the description of the data.

The label field allows the label of the parameter to be displayed in the soft-
ware. Examples are V, mA, pH, G, etc.

The gain and offset fields are the equivalent of the “m” and the “b” respec-
tively in the “Y = m * X + b” equation. X is the raw data from the device and 
Y is the data displayed by the software.

Choose the Scaled Engineering Units dropdown list to select the unit ID. If 
Use Next Available Unit ID is set as the default, the software will assign the 
next available unit ID to the created unit.

If the checkbox Save these units when program closes, screen shot bottom 
of Edit Engineering Units, is checked when the program closes, the created 
unit will be saved in the software after the software is closed. Otherwise, the 
created unit will be lost after the software closes. Edit a unit and uncheck this 
box to remove the unit from the list.

Engineering Units List 

The Engineering Units List tab will display all the customized engineering 
units. To edit a record, highlight it. The information will be displayed in the 
Edit Engineering Unit’s Recorder Units section (see previous page). 
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Note: The Show all units checkbox defines the status of both Engineering 
Units List tab and Use Next Available Unit ID dropdown list box. If checked, 
all available unit ID’s will be displayed on both fields. The unit ID range is 
0-255.

Standard Units List

The Standard Units List tab will display all the available unit type(s) that can 
be used to make customized engineering units.
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Communication Menu
The Communication Menu displayed below

Communication Menu: Auto Configure Port

Select Auto Configure Port from the Communication Menu to automati-
cally indicate which COM/USB port the device is attached and which baud 
rate the device uses to communicate. This command operates only when an 
interface cable is connected to an available COM/USB port and a functioning 
data logger. If this command fails to find the device, then the device is not 
functioning properly or the interface cable is not properly connected. Once 
the software has identified the COM/USB port and the proper baud rate, the 
information will be stored in the configuration file. This command only needs 
to be activated once. If a different COM/USB port is later used, or if a device 
with a different baud rate is used, then re-select the command.

Communication Menu: Select Comm Port

Select the Comm Port to manually set/choose the communication/USB port 
in which to connect the data logger. The correct COM/USB port must be 
selected or the software will not to communicate with the data logger. To 
automatically configure this option, refer to Auto Configure Port, above.

Communication Menu: Select Baud Rate

Select the Baud Rate from the Communication Menu to manually set the 
speed to use to communicate with the data logger. The correct baud rate 
must be selected, to allow the software to communicate with the data log-
ger. To automatically configure this option, refer to Auto Configure Port, 
above.
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Communication Menu: Accept Real Time Wireless Input

Selecting Accept Real Time Wireless Input from the Communication Menu 
enables the software to accept real time readings from wireless transmitting 
devices. To accept these readings, the computer must have an RFC101A 
interface cable connected to an available COM port and the transmitter must 
be enabled to transmit.

Note: The RFC101A has a baud rate of 4800. The user must manually config-
ure this baud rate. See Communication Menu: Select Baud Rate, page 45.

Communication Menu: Wireless Modem Setup

Select Wireless Modem Setup from the Communication Menu to activate 
the following window:
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This window allows the user to enter the RF Extender settings. The RF Ex-
tender allows the MadgeTech data logger to be remotely accessed up to one 
mile away from a computer, for more information about RF Extender see 
Quick Start Menu and Operations Manual for RF Extender Setup at 
www.madgetech.com. Not all data loggers are capable of wireless remote 
operation.

Network

The Network (the host computer’s network) Address and Module (the RF 
Extender ) are used to distinguish the RF devices from other devices. The 
Network Address can be configured for up to 7 different networks (0-6). 
The Module Address can be configured for up to 65536 different addresses 
(0-65535).

Communication

The Baud Rate parameter may need to be changed. Select the baud rate 
in the RF Extender dropdown list from the drop down menu to match the 
baud rate of the data logger which will communicate with the RF Extender. 
Keep the other default RF Extender settings unless they are required to be 
changed.

Send Command

Select the Send Command button to use with the Command dropdown 
list.

Read Config 

Select the Read Config button to display the RF Extender’s current configu-
ration.

Write Config 

Select the Write Config button to store the configuration in the non-volatile 
memory where it will not be lost when the power is cycled.

Send Config 

Select the Send Config button to store the configuration in the temporary 
buffer where it will be lost when the power is cycled.

All other configuration fields are not necessary by default.
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Communication Menu: Modem Connection 

Select Modem Connection from the Communication Menu, page 45, to 
the following window:

Enter the telephone number (required) and other modem settings (not 
required, marked by red asterisk) in this screen. The software will read data 
from a remote device equipped for modem data transfer, not all data loggers 
are capable of remote operation.

Connect Button 

Select the Connect button to connect to the remote station.

Disconnect Button

Select the Disconnect button to disconnect from remote station.
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Device Menu
The Device Menu will appear as shown:

Device Menu: Identify Device and Read Status 

Select Identify Device and Read Status from the Device Menu to allow 
software to communicate with the attached data logger and display a win-
dow similar to this one:
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Device Status Tab
The Device Status tab displays the device type, revision number, serial num-
ber, Extender (user) ID, and operating parameters of the particular device 
in the Device Status dialog box. The serial number is set at the factory and 
cannot be changed by the software. The Device ID can be selected when 
starting the device. This command will also verify that the software is able to 
communicate with the device and that the correct COM/USB port has been 
selected. If the device does not communicate, verify the following:

- Are the COM/USB port and baud rate correct?

- Is there another device using the selected COM/USB port, such as a 
modem or PDA?

- Is the device’s battery dead?

- Is the Interface Cable connected to the correct COM/USB port?

In addition, this command will read and indicate the current status and all 
pertinent information of the device that is connected. This provides a quick 
method for determining the current state or status of a particular device.
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Device Detail Tab

The Device Detail tab displays the details of the device. An example of a 
Temp101 data logger is seen in the screen below:

The details include device type (device name as heading), revision number, 
subtype, and channel information. Information about Alarm Setting, Ther-
mocouple Type, Engineering Units, Trigger Settings, Wireless Configuration, 
Wrap Around and Calibration will be displayed when the device supports 
these features. 

Note: When these features exist, a corresponding button will be displayed on 
the lower right side of the screen. An Alarm Settings & Calibration button are 
displayed in the example on the screen above.

The following details are described as follows:

Alarm Settings 

Select Alarm Settings to display an alarm setting screen that will permit the 
alarm range to be changed. See page 81 for full operating instructions.
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Password doesn’t exist.

Password exists.

Set Password

Click Set Password to password protect the device. 
 
 
 
 
 
 
 
 
 

The software will remember the device password after it has been set. The 
password will be asked next time when the user analyzes the device data.
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Thermocouple Type

Select Thermocouple Type to display a thermocouple type window to re-
quest the input of the thermocouple type being used. This command is only 
available for devices that use thermocouples as the sensing element, such 
as the TC4000, TC110, QuadTemp, and OctTemp. The device will config-
ure itself appropriately for the chosen type of thermocouple. The device 
requires this information to properly make temperature measurements and 
automatically perform the thermocouple cold junction compensation. Upon 
activation of this command, the software communicates with the device to 
determine if it has a programmable thermocouple attached. If it does, the 
following window appears:

 
 
 
 
 
 
 
 
 
 

To change the thermocouple type, select the Change button. To commit 
the change, select Save to store the thermocouple type in the device. After 
selecting the thermocouple type, the temperature range for the chosen ther-
mocouple is automatically displayed.

Engineering Units (device/software level) 

The Engineering Units command is only available when a data recorder 
with this feature is connected to the host computer. Multiple engineering 
units can then be defined into multi-channel recorders.

Note: If the software level engineering units does not have the record of device 
engineering unit, a new software level record of device engineering unit with 
an unique unit ID will be created when Identify Device and Read Status are 
performed (see page 49).
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1. Device Units

The Device Units tab contain the engineering unit(s) of the device con-
nected to the host PC. The Device Units Wizard button (1) will automati-
cally edit the device’s engineering units or it can be done manually using the 
Change device settings button (2). Save the changes into the device select 
the Save changes to device button (3).

(1) (2)

(3)
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 A. Device Units Wizard
The Device Units Wizard will calculate the device unit(s) based on the user’s 
inputs. 

B. Edit Device Units 

When Edit Device Units is enabled, the engineering units of the device can 
be edited directly. Otherwise the user needs to select the Change device 
settings button (see buttons on previous page) to enable this part first. 

Note: The Use portable units on this device checkbox defines the status of two 
dropdown list in the Device Units field. If it is checked, both of the dropdown 
lists will show all channels and portable units.
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Enable Engineering Units 

The Enable engineering units on this device option indicates if the units 
programmed into the device should be displayed when data is downloaded. 

Prompt for unit selections on download 

The Prompt for unit selections on download option allows the stored 
information to be edited each time the data is uploaded.

Portable Units

The Portable Units tab contains description, label, gain, and offset fields.

The description field is used to enter the full name of the parameter to be 
displayed in the software. Examples of this are Volts, Milliamps, pH, Gallons, 
etc. This name is displayed on the graph and data table as the description of 
the data. 

The label field is used to enter the label of the parameter that is to be dis-
played in the software. Examples are V, mA, pH, G, etc. The gain and offset 
fields are the equivalent of the “m” and the “b” respectively in the  
“Y = m * X + b” equation. X is the raw data from the device and Y is the  
data displayed by the software.
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Device Units List

The Device Units List tab shows all channels and their corresponding unit. 

Note: To assign the engineering unit to the specific channel, select the chan-
nel and choose the record from Engineering Units List (see below). If the unit 
assigned to the channel is a software level (not device level) engineering unit 
then the Use portable units on this device option in Portable Units will be 
unchecked.

Engineering Units List

Unit Description Unit Label

Speed m/s (meter/scale)

Concentration PPM

Pressure PSI

Metering Watts, gallons

Level Inches

pH pH
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Engineering Units List

The function of the Show all units checkbox is described in Software Level 
Engineering Units List, page 53.

Standard Units List

The Standard Units List tab will display all the available unit types that can 
be used to make customized engineering units.

2. Engineering Units
The Engineering Units tab will be the same as Software Level Engineering 
Units, page 53.

Note: The edibility of the Device Units and Engineering Units tabs will be 
opposed so they cannot be edited at same time.
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Trigger Form 1:
With sample count

Trigger Form 2:
Without sample count

Trigger Settings

Select Trigger Settings from the Device Menu: Start Device or Identify 
Device and Read Status. This command is only available when the data 
recorder has the Trigger feature. The trigger screens offered depend on 
the type of data recorder connected to the host computer. Trigger screen 
samples are shown below.

Device has one triggered channel

Trigger formats with one mode of operation fall into two types: With or 
Without settable sample count.



Page 60

MadgeTech Operating Manual

Trigger Form 3:
Window, the function 
of this form is similar 
to Trigger Form 1

To edit trigger values, click the Change button. The values can be typed in 
directly, or changed using the slider control.

NOTE: The high and low triggers cannot be disabled simultaneously. 

The values for the high or low trigger points can be set. Enable the high 
trigger to allow the acquisition of data to begin if the point is greater than 
the high set point. Enable the low trigger to allow the acquisition of data to 
begin if the trigger level is less than the low set point. The trigger sample can 
be set up to count by;

1. Typing in their readings count number or 

2. Select Fill Memory on First Trigger option to get the maximum read-
ing counts on a single event.

Trigger formats with two trigger mode options fall into two types: Window 
and Two Point.
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Trigger Form 4:
Two Point Mode

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Two Point Mode allows for a High Trigger and Low Trigger. There will be two 
separate areas of pressure that can enable a trigger.
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Device has three triggered channels

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To edit trigger values, click the Change button. The values can be typed in 
directly, or changed using the slider control.

NOTE: At least one axis must be selected. 

Calibration

Select Calibration to display a calibration screen that will permit the device 
to be calibrated. See page 79 for full operating instructions.
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Device Menu: Read Device Data 

To download the data from the device to the computer, select Read Device 
Data from the Device Menu. This command automatically downloads all 
the stored data from the device and displays it in both graphical and tabular 
format. The standard Temp101 will download data at approximately 120 
readings per second. A progress bar located near the bottom of the screen 
gives a visual indication of how long the download will take.

Note: The data logger continues to record after the data has been download-
ed. Use Stop Device, page 69, to stop the data logger from taking readings.

Device Menu: Quick Start

Select Quick Start from the Device Menu to start the device without asking 
for any settings. It will use the previously set user ID and reading rate. This is 
useful for saving time, especially when programming multiple devices with 
the same parameters.
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Device Menu: Batch Start

Select Batch Start from the Device Menu to display the following window:

Device Parameters Tab

The Device Parameters tab has similar functions to Start Device (page 66). 
The availability of Device ID field, Extended ID field, Reading Rate, and Wrap 
Around field (option available depending on device) depends on the selec-
tions in the Configuration tab. If the device has the alarm setting feature 
then a corresponding button will be displayed on the screen. An Alarm Set-
tings button is displayed on the screen above.
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Configuration Tab

The Configuration tab has five selectable parameters; Device ID , Extended 
ID , Reading Rate , Wrap Around , and Alarm Settings options. The avail-
ability of these fields depends on the features the device supports.

Device ID 

Check the Device ID box to give the device up to a 6-character name in the 
Device Parameters tab. 

Extended ID 

Check the Extended ID box to give the device an additional 16-character 
name in the Device Parameters tab.
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Password

If the device has the Password feature then the Password box is enabled and 
a password button appears on the right side of the screen which allows edit-
ing Device Password.

Alarm Settings 

Check the Alarm Settings box to enable the alarm setting feature from the 
Device Parameters tab (screen previous page).

Reading Rate 

Check the Reading Rate box to choose the reading rate from the Device 
Parameters tab.

Wrap Around 

Check the Wrap Around box to choose the wrap around memory feature 
from the Device Parameters tab.

Device Menu: Start Device 

Select Start Device from the Device Menu to display the following window:
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Note: Starting the device will erase all readings currently stored in its memory.

The Start Device window allows the start time and reading rate to be set. 
The Start Method setting may be used, along with the Start Now radio 
button, to start the data logger immediately. Alternatively, the user can select 
the Delay Start option to delay the start of data collection. The start time 
may be delayed up to six months from the current time. The Pushbutton 
Start option can be selected to start the data logger by pushing the push-
button on the device. The push button must be pushed down and held 
for at least 3 seconds.

When the device has a feature such as alarm setting, thermocouple type, 
trigger settings, wireless configuration and engineering units then a corre-
sponding button will be displayed on the screen. An Alarm Settings button 
is displayed in the example below in the lower right hand portion of the 
screen. 

For some types of data loggers, the following window may appear:

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The device start time may be delayed after the start button of the data log-
ger has been pushed. This time will depend on the value of the delay start. 
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The reading rate can be selected to determine its data recording frequency. 
When selected, the maximum recording time will be calculated for the par-
ticular device, based on its internal memory capacity, and displayed in Log 
Time box. Once started, the device will continue to record readings until its 
memory is full, unless the Wrap Around feature is enabled. When full, the 
data recorder will stop recording additional readings, then place itself into a 
low power state to maximize battery life. The data stored in the data logger 
is always preserved (even in the case of battery failure) unless the device is 
reset or started. When re-started the existing readings are then overwritten.

For some types of data loggers which have the stop feature, the following 
window may appear: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Manual Stop (default option for logger operation)

The device will continue to record data until the memory is full, or until the 
device is stopped manually using the MadgeTech software.

Stop on Date

The user can specify a time at which the device will stop taking readings to 
memory. A stop date can be specified up to a year in advance.
Note: If the Wrap Around feature is activated a stop date will not be possible 
to set.
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Stop after Readings

The user can specify the number of readings the device will take. Any num-
ber of readings can be specified up to the maximum number of readings 
supported by the device.

Note: If the Wrap Around feature is activated a stop date will not be possible 
to set.

Device ID 

A Device ID may be entered in the space provided in any combination of 
six letters and/or numbers. The Device ID is written to the device and will 
appear in graphs or reports when the device is read later. Use it for identifica-
tion of the device or personnel linked to the device, etc.

When all parameters/settings are set, press Start Device to program and 
begin recording data.

Device Menu: Stop Device 

Select Stop Device from the Device Menu permits the software to commu-
nicate with the data logger and stop it from taking additional measurements. 
The data logger will enter a low power state to conserve battery life and 
when the memory is full. When full, the data recorder will stop recording ad-
ditional readings and place itself into a low power state to maximize battery 
life automatically, this is simply a convenient way to extend the life of the 
battery. This mode is obvious to the user because the device will immediately 
wake up when the host computer communicates with the logger. When the 
device will not be used for a long period of time, stopping the device from 
collecting more data will conserve power to extend battery life. Stopping the 
device has no effect on the data in memory, the data is always retained. 

Device Menu: Reset Device 

Select Reset Device from the Device Menu to permit the software to 
communicate with the data logger device, and stop it from taking further 
measurements. This will also erase all readings currently stored in memory. 
Resetting the device will cause the data logger to enter a low power state to 
conserve battery life. 
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Device Menu: Real Time Chart Recording 

The Real Time Chart Recording command provides a graphical method for 
acquiring and viewing data in real time. Choose the Real Time Chart Re-
cording command to select the menu items and toolbar to appear as shown 
below:

A logger must be connected to the interface cable to select and use the 
following features: reading rate, setup real time recording parameters, and 
start and stop the real time graphing.

Note: Data is not stored internally in the data logger while in Real Time Re-
cording mode.

Start Recording 

Select the Start Recording button to take a reading from the logger and 
update the screen at the selected reading rate.

Done Recording 

Select the Done Recording button to discontinue recording from the logger. 
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An example of a real-time graph, using a Temp101 temperature logger:

Note: The pink area is the warning area for high alarm setting of the data 
logger, the light blue area is the warning area for low alarm setting of the 
data logger if it has alarm the setting feature.

When the data has been accumulated in real time it can be saved and 
viewed in the same method as data that has been downloaded from a 
device. The data can also be viewed in tabular format while in the real time 
mode. Switching back and forth from a graphical to a tabular format is easily 
done. While in the real time recording mode, access to most software com-
mands is restricted to eliminate interference with data collection. All win-
dows except for the current window are inactive during data collection.
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Real Time Setup 

From the Real Time Chart Recording on the Device Menu, select the  
Recording Setup Button. This will display the following window:

Recording Parameters Tab

The Recording Parameters tab allows for set up of the recording start and 
end time.

Start Method: Start Now or Delay Start

Select Start Now to begin recording immediately or select Delay Start to 
delay the recording.
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End Method: Manual or Select Time

There are two methods to end Real Time Recording:

1) manually

2) automatically

To end Real Time Recording manually select the Done Recording button 
on the Real Time Chart Recording Toolbar, page 70. To end automatically 
choose select time from the Real Time Setup screen, previous page.

Reading Rate

Select the Reading Rate from the dropdown list. To setup the Real Time Re-
cording rate click the Start Recording button to start real time recording.

Alarm Settings Tab (software level)

The Alarm Settings tab selected in the screen below, allows the user to set 
up and receive alarm notification in two different ways,  namely screen alarm 
and e-mail alarm.
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There are three steps to setup the alarm:

1. Notification Types
- Check Screen Alarm box to show alarm information on the screen. 
- Check Email Alarm box to receive an alarm warning message by email   
  or by text messaging.

2. Notification Settings

To receive an alarm warning message for every reading that is outside of 
the programmed alarm range select the notify every out of range reading 
option to receive an alarm.

To receive an alarm warning message only once when the first time the 
alarm range is out of the alarm setting, select the notify only on initial 
out-of-range reading option.

The alarm warning message can be received at certain time intervals 
when the alarm range is out of the alarm setting.  To enter the interval 
time desired use the notify every XX:XX:XX while reading is out of range

3. Channel Settings

Select the channel and then the unit for the channel by clicking the Chan-
nel and Units dropdown boxes, respectively. It will affect the graph’s unit on 
the screen, but not the unit preferences. Check the Low Alarm and/or High 
Alarm boxes and enter a low alarm value and/or a high alarm value for the 
selected channel and unit. Click the “Add/Modify” button, and the low and/
or high alarm will be populated in the grid.
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Multiple channel alarms can be set.

The screen alarm notification window.
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Email Information Tab

Use the Email Information tab to set up email information. Fill in required 
fields with the correct information. Select the Test Account Settings button 
to confirm the settings work correctly. 

Message Options
The Long Text Format and Short Text Format permit alarm notification by 
email. The Short Text Format is typically used for text messaging systems 
such as Cell Phone.

The Use Proportional Font option relates to the font output of the data. 
When checked, fonts will be sent in a proportional font, e.g. Times New Ro-
man. When unchecked, fonts will be sent in a fixed width font, e.g. Courier.
 
Note: An internet connection must be enabled on the host computer for this feature to 
work. Please refer to the host computers Windows Operating Manual for specifications. 
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File Settings Tab

The File Settings tab is to manage files.

Data Save 

The Data Save option allows data to be saved automatically and sets a save 
location for the Real Time Recording Data. See page 18 for Save file types.

Data Export 

The Data Export option allows data to be exported automatically and sets a 
default export location for the Real Time Recording Data.

Preferences 
The Preferences option allows the save and export features to occur auto-
matically at set time intervals (see screen on previous page).
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Device Menu: Display Real Time Wireless Data

The Display Real Time Wireless Data command displays real time readings 
from RF series data loggers. The real-time data can be viewed in a graphical 
or tabular format, just like in Real Time Chart Recording. To accept RF read-
ings, the computer must have an RFC101A interface cable connected to an 
available COM port, and the transmitter must be enabled to transmit.

Note: The RFC101A has a baud rate of 4800. The user must manually config-
ure this baud rate. See Communication Menu: Select Baud Rate, page 45.
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Device Menu: Calibration

Select Calibration from the Device Menu (see screen on following page). All 
data logger devices can be calibrated through the software. This eliminates 
the need for opening the device or adjusting potentiometers. Calibration 
parameters, as well as the last calibration date, are stored within the device 
itself in non-volatile memory. This can be accessed through the software. It 
also allows the device to maintain calibration while being used on any com-
puter. Most data loggers can be effectively calibrated using a single point to 
correct an offset. In some cases, two points may used to correct for gain and 
offset errors. The Temp101 uses a single point calibration. The calibration 
offset is defined as the value the device reads at zero. Thus, if the Temp101 
reads 0.5 ºC when the correct value is 0 ºC, the user would enter 0.5 ºC for 
the calibration offset. The 0.5 ºC would then be subtracted from each read-
ing downloaded from the device, and the data would be correct without 
any further manipulation. The Temp101 Calibration window, shown on the 
next page, is displayed when the Calibration command is selected, and a 
Temp101 is connected to the interface cable. To edit the calibration values, 
click on the Calibrate button. The Default button may be used to return all 
values to their default settings (0.000 for offset values, and 1.000 for gain 
values.)

Sample Calibration Screen
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For convenience, a Wizard button is available. Select this button to display 
the Calibration Wizard, a series of screens with fields can be fill in regard-
ing the behavior of the un-calibrated (all values set to the default) device. 
The wizard performs the calculations for the offset and/or gain values and 
puts them into the correct fields in the calibration window. To commit to any 
changes, select Save to store the calibration information in the device. The 
calibration is then saved, and the new calibration values are displayed.

The Calibration Wizard

The Calibration Wizard displays information which correlates to the type 
of device attached. The following screen is an example of a Temperature 
Gain/Offset calibration on the Temperature channel of a Temp101 device. 
To calibrate the device select the Next button, complete the required fields 
for each channel of the device, and select the Next button again until the 
Wizard highlights the finished button. Select the Finish button and the 
calculations are made and the correct values are placed into the Calibration 
windows. Select Save to save these values into the device.
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Without Alarm Delay

Without Alarm Warn

With Alarm Delay

Without Alarm Warn

Device Menu: Alarm Settings

From the Device Menu, choose Alarm Settings. This command is only avail-
able when a data logger with this feature is connected.
This command allows the high and low temperature points to be set, also 
high and low warn temperature points can be set if the device has this fea-
ture, a visual alarm (flashing LED, the RED one indicates the exceed range of 
high and low alarm and the YELLOW one indicates the exceed range of high 
and low alarm warn) will be triggered. If the device has the time delay fea-
ture, the time delay can be set to trigger a visual alarm. These points should 
be set in the units indicated.
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With Alarm Delay

With Alarm Warn

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To edit these alarm values, select the Change button, as shown in the win-
dows above.

By default, the Clear alarm status when setting reading marker check box 
is unchecked. If it is checked, the user can press the push button of device to 
set the reading mark and clear alarm status (high and low alarm, high and 
low warn, and alarm delay) during the reading period.

Select Save to store the values into the device. When the alarm values are 
stored into the device, they are rounded to the nearest alarm set point for 
that device. Once the alarm has been tripped (e.g. the temperature has gone 
outside the set limits), the LED will flash at a one second reading rate until 
the device is reset or the alarm is deactivated by the Alarm Settings Disable 
command. It is important to remember that the device only takes readings at 
its programmed reading rate.

NOTE: If a temperature travels outside the set limits between readings, it will 
be missed by the device and the alarm will not become active.
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Graph Menu
The Graph Menu appears like this:

Graph Menu: Show Summary

Select the Show Summary command from the Graph Menu to display the 
Summary tab, which will appear as follows on the next page:
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Sample Statistics for Temp101

Graph Menu: Show Composite Graph

Select the Show Composite Graph command from the Graph Menu to 
display the Composite Graph tab, which will appear as follows:

Composite Graph Tab

The Composite tab displays a graph of one or more datasets. Datasets can 
be loaded by using the Open command from File Menu, page 16. Once 
loaded, they are displayed as graphs.
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To display the dataset(s) select one from the dropdown list at the top-right 
corner of the composite graph (see below). Select the checkbox next to the 
list to select or deselect the dataset(s) for display. Deselecting the dataset(s) 
does not unload it , it remains in memory and can be reselected at any time.

To unload a dataset from the memory, select it from the dropdown list at the 
top-right corner of the composite graph. Select the X button on the right to 
unload the dataset (see below). Once a dataset is unloaded, it cannot be 
redisplayed without reloading it using the Open command from File Menu.

To manipulate multiple datasets simultaneously, select the ellipses (…) 
button in the middle to open Graph Configuration form (see next page). 

Deselect Dataset 

To deselect dataset(s) for display on the composite graph, uncheck them.
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Unload Dataset 

Highlight dataset(s) and press the Remove button to unload them from 
memory. 

Unload Data Set into Temporary Buffer

Select the Remove button to place the unloaded dataset(s) in the tempo-
rary buffer, rather than unloading them permanently. They can be restored 
or reset. After selecting the Apply button or the OK button, the unloaded 
dataset(s) cannot be redisplayed without reloading them using the Open 
command from File Menu. 

Graph Menu: Show Graph

Select the Show Graph command from the Graph Menu to display the 
Graph tab. This tab is similar to the Composite Graph except that only one 
dataset can be displayed at a time.
Note: In order to save a dataset, it must be displayed in the Graph or Data 
tab.

Graph Menu: Show Data Table

Select the Show Data Table command from the Graph Menu to direct the 
software to display the Data tab as shown in the window on the following 
page.
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Data Tab

The Data tab displays data in table format, to easily determine the exact 
value of each data point.

Graph Menu: Select Graph Tool

Select the Select Graph Tool command from the Graph Menu to enable 
the cursor mode which the mouse will assume when it is pointed and clicked 
over the graph. Several cursor modes are available, each with a specific func-
tion as follows:

Cursor 

When the cursor mode is selected: 

1. Click on a data point of the graph to indicate the value.

2. Click on or near a data point on the graph to indicate the value of 
the data point.
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The data point selected can be changed by navigating the cursor or;

    A. Use clicking method.

    B. Click and drag the mouse horizontally in the graph.

    C. Use the arrow keys (left, right) on the keyboard.

Time Cursor 

When this cursor mode is selected, choose one of the following methods;

1. Click and drag the mouse horizontally over the graph area or  

2. Use the arrow keys (left, right) on the keyboard, to indicate the time 
and value of each data point the cursor passes over.

Scroll 

Select the cursor mode to scroll the graph in any direction to view a particu-
lar section. To scroll the graph, click and hold the mouse button, then drag 
the mouse in the direction desired. When dragging the cursor a line with an 
arrow is drawn to indicate the direction and amount of the scrolling opera-
tion. When the mouse button is released, the graph is then scrolled in the 
direction and by the amount specified.

Zoom In 

When this cursor mode is selected, click on the graph to zoom in for a close-
up view of a particular area of the graph. Multiple zooms may be performed 
to obtain best view. The software can only zoom in to a limited extent. If the 
zoom limit is reached, the following message will be displayed.

Message Box 1: Warning for Zoom In
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Zoom Out 

When this cursor mode is selected, click on the graph to zoom out for an 
overall view of a particular area of the graph. Multiple zooms may be per-
formed to obtain the best view. The software can only zoom out to a limited 
extent. If the zoom limit is reached, the following message will be displayed.

Message Box 2: Warning for Zoom Out

Box Zoom 

Select the cursor mode, then click and drag on the graph to draw a rect-
angle. When the mouse button, is released the graph will zoom in to obtain 
a close-up view of that area of the graph.

Horizontal Zoom 

Select the cursor mode, then click and drag on the graph to draw a horizon-
tal rectangle. When the mouse button is released, the graph will zoom in to 
get a close-up view of that area of the graph.

Vertical Zoom 

Select the cursor mode, then click and drag on the graph will draw a vertical 
rectangle. When the user releases the mouse button, the graph will zoom in 
to get a close-up view of that area of the graph. 

Cancel Zoom 

Select Cancel Zoom to cancel any zoom modes. The graph will be redrawn 
in its default state.
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Graph Menu: Title Graph

This feature will be disabled when no dataset is displayed on the screen. 
Otherwise, there are two ways to modify the title graph. 

1. The title graph can be modified by selecting Title Graph from the Graph 
Menu (page 83) or The Right Click Pop-Up Menu (page 101). 

The following screen will appear:

2. Double click the graph title area, to highlight and modify it.

Graph Menu: Annotate Data

This feature will be disabled if there is no channel selected. Otherwise, there 
are two ways to annotate data. 

1. Select Annotate Data from the Graph Menu or right click the Pop-Up 
Menu. The following screen will appear:
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2. Double click the annotate data area on the heading of the graph. Type the 
annotation in the box as shown below:

Graph Menu: Autoscale Graph 

Select the Autoscale Graph command from the Graph Menu to optimize 
the vertical scale of the graph to match the minimum and maximum data 
points shown on the graph. This provides maximum resolution for viewing 
the graph.

Graph Menu: Set Graph to Preferred Scale 

Select the Set Graph to Preferred Scale command from the Graph Menu 
to set the graph to the preferred scale.

If no preferences are set, the graph will show on the vertical scale, the mea-
surement range of the device (this may differ from the rated operating range 
shown on the label of the device). The time scale will begin when the first 
reading was taken, and end when last reading was taken.

Graph Menu: Synchronize Graph Scale 

Select the Synchronize Graph Scale command from the Graph Menu to 
synchronize the time and value axes of the graph.

Graph Menu: Select Graph Units

Select the Select Graph Units command from the Graph Menu to select 
the units to be used when displaying the graph. The available units will vary 
depending on the type of data logger used. For example, the Temp101 
reads temperature and provides units of degrees Celsius (ºC), Fahrenheit (ºF), 
Rankin (ºR) or Kelvin (K). The RHTemp101 records temperature and humid-
ity and has available °C, °F, °R, and K for the temperature reading, and %RH, 
Dew Point and Water Vapor Concentration for the humidity reading.
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Graph Menu: Set Graph Scale 

Select the Set Graph Scale command from the Graph Menu to manually 
change and specify the values of the vertical and horizontal axis. The follow-
ing three screens are shown for each of the tabs:

Time Tab

Scale Tab

Note: In order to enter the low value or the high value of the unit a unit from 
the Select Units dropdown list box must be selected first. There is no unit 
selected if the value of the Select Units dropdown list box is No Units Selected.
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Axis Tab

Different data recorders will show a slightly different window depending on 
the number of channels and the parameters being recorded. Scaling of the 
horizontal axis is controlled by the Select Time Range section. To set the 
end points of the horizontal axis, select the specified endpoints from the 
dropdown date and time selectors. The vertical axis is set using the Vertical 
Scale tab.
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Graph Menu: Format Graph 

Select the Format Graph command from the Graph Menu to display the 
following window:

Edit Formatting Options to apply formatting to the single graph, the 
composite graph, or both.
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Graph Format Tab
Select the Graph Format tab to set the background color for the entire 
graph, as well as the color and number of the major and minor grid lines. 
Changes are applied to the dataset selected at the top of the frame.

The Data Format looks like this:

Data Format Tab
This window allows the user to customize the look of the graphical data for 
each dataset. First, select the dataset to customize from the dropdown list. 
Choose the channel from the second dropdown list (some devices have 
multiple channels). Then, select the thickness of the line, line color, symbol 
style, and symbol color from the remaining dropdown lists. Finally, select the 
symbol size and frequency (see Manipulate Plotting Symbol, next page) 
and whether the channel should be visible or not (see Hide Selected Chan-
nel and Show Hidden Channels, next page). 
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Manipulate Plotting Symbol

The Select Symbol Size slider and the Select Symbol Frequency slider are 
used to manipulate the plotting symbols. The zero setting removes all plot-
ting symbols, and higher settings will approximately double the number of 
symbols on the graph as the slider is moved up one notch.

Hide Selected Channel 

Uncheck the Channel Visible option to hide the selected channel or choose 
The Right Click Pop-Up Menu (page 101) to hide the selected channel. 

Show Hidden Channels 

Check the Channel Visible option to show the hidden channel. Click OK, 
the graph will be immediately redrawn with the option chosen. Choose the 
Right Click Pop-Up Menu to show the hidden channel also.

Graph Menu: Copy Data To Excel® 

Select Copy Data To Excel® to allow the software to launch the Microsoft 
Excel® spreadsheet program, and copy the current dataset to an Excel® 
worksheet. This command will only work with a compatible version of Excel® 
properly installed on the host computer.

Graph Menu: Device Detail

Select the Device Detail command to display the device details of the 
selected dataset. This will include device type, revision number, subtype, 
and channel information. Information about alarm setting, thermocouple 
type, wireless configuration, wrap around and engineering units may also 
be displayed if the device supports those features. The window is similar to 
Identify Device and Read Status features, page 49.



Data Logger Software

Page 97

Select the Alarm Setting button from the Device Detail tab to display a 
read-only alarm setting screen to show the alarm range. This command is 
only available when the selected dataset is generated from a device that has 
this feature. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Select Thermocouple Type button from the Device Detail tab to display a 
read-only thermocouple type screen. This command is only available when 
the selected dataset is generated from a device that has this feature.
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Select Calibration button from the Device Detail tab to display a read-only 
calibration form that shows the user the device of the selected dataset cali-
bration information.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select the Engineering Units button from the Device Detail tab to display a 
read-only engineering units screen. This command is only available when the 
selected dataset is generated from a device that has this feature.
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Trigger Settings

Select Trigger Settings to display a read only trigger setting screen. See 
page 59 for full operating instructions. 

Graph Menu: Statistics

Select the Statistics command to calculate some basic statistics for data on 
each individual channel. A typical screen for some calculated statistics for the 
temperature channel of a Temp101 might appear as follows:

For data recorders with more than one channel, the Next and Previous 
buttons will be available. This allows the user to quickly view the statistics on 
each channel. In the example for the RHTemp101, activating the Next 
button will update the dialog box with the statistics for the humidity chan-
nel.
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Graph Menu: Set Cooling Flags
Select the Set Cooling Flags command to allow the user to set the cooling 
flags on the temperature channel of the selected dataset. Checking the “En-
able Cooling Flags” checkbox enables the Flag Settings to be entered.  When 
the “Autoflag at Reading Data” checkbox is checked and the Save button is 
clicked, cooling flags will be drawn automatically the next time data is read.

 
 
 
 
 
 
 
 
 
 
 
 
 

A typical screen for setting the cooling flags for the temperature channel of a 
Temp101 might appear as follows: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE: In order to set the cooling flags, the selected dataset must be dis-
played in the Graph tab and have at least one visible temperature channel.
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The Right Click Pop-Up Menu
The Right Click Pop-Up Menu incorporates menus from the Graph Menu. 
It provides a convenient way to manipulate the graph. It will show different 
pop-up menus depending on the position of the mouse on the screen.

The Right Click Pop-up Menu will appear one of two ways (see page 105).

Window #1:
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Submenu A

Click the Title Graph submenu to modify the title graph. See Title Graph, 
page 90.

Click the Annotate Data submenu to modify the Annotate Data. See 
Annotate Data, page 91.

Click the Show Summary, Show Composite Graph, Show Graph, and 
Show Data options to bring up the Summary, Composite Graph, Graph, 
and Data tabs, respectively.

Submenu B

Highlight Select Graph Tool to change the cursor mode. See Select Graph 
Tool, page 87.
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Highlight Select Graph Units to change the type of scaling units. See Select 
Graph Units, page 91.

Highlight Graph Scale to bring up the following box.

Click the Autoscale Graph option to automatically optimize the vertical scale 
of the graph. See Autoscale Graph, page 91.

Click the Set Time Scale submenu to display a time scale setting form. See 
Set Graph Scale, page 92.

Click the Set Vertical Scale submenu to display a vertical scale setting form. 
See Set Graph Scale, page 92.

Highlight Graph Format to bring up the following box:
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Click Format Graph to display a graphic format setting form . See Format 
Graph, page 94.

Click Format Data to display a data format setting form .

Click Show Hidden Channels to show all hidden channels in the graph. 

The Hide Selected Channel is available when there is a channel selected on 
the screen. The Hide Selected Channel function, page 96 in the Format 
Graph menu, page 94 to hide the selected channel.

Submenu C 
 
 
 
 
 
 

Click Select Axis Labels to bring up the Set Graph Scale box, under the Axis 
Labels tab. The user can choose which vertical labels are shown and whether 
they will be shown on the left or right sides.

Use 24 Hour Time Format, Use UTC Standard Time, or Use UTC Abbrevi-
ation to change the way the time is viewed. See Display Preferences, page 
32. 
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Window #2

The Right Click Pop-up Menu will appear below if there is no channel  
selected on the screen by the user.

Here the Right Click Pop-up Menu is similar to Window #1 with two differ-
ences: 

1. The submenu Annotate Data is not available.

2. The submenu Hide Selected Channel is not available in Graph For-
mat menu. 
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Window Menu
The Window menu looks like this:

Window Menu: Stack

Choose Stack from the Window Menu to resize all the open graph windows 
to take up the whole main window and are to stack (overlay) on top of each 
other.

Window Menu: Cascade

Select Cascade from the Window Menu to resize all the open graph win-
dows to a medium size, and then positions them in a staggered layer, one on 
top of the other, to maintain the title bars are visible.

Window Menu: Tile Horizontal

Select Tile Horizontal from the Window Menu to rearrange the open graph 
windows, to make fully visible and to align horizontally next to each other 
with no overlapping.

Window Menu: Tile Vertical

Select Tile Vertical from the Window Menu to rearrange the open graphs 
windows to make fully visible and to align vertically next to each other with 
no overlapping.

Window Menu: Selected File

When only one graph menu with multiple data sets is open, the line will 
show the selected tab that is open in the graph menu.

When multiple open graph menus are open with different data set(s) in each 
one, all the file names will be listed under this option. This method allows a 
desired graph to be viewed.



Data Logger Software

Page 107

Help Menu
The Help Menu looks like this:

Help Menu: Contents

Select Contents from the Help Menu to bring up the Help window and 
display the Table of Contents for the online manual.

Help Menu: About

Select About from the Help Menu to bring up the About window and 
display information about the company and the software version. This screen 
includes the MadgeTech, Inc. address, phone number for technical informa-
tion, e-mail address and web site. It also includes the full revision number of 
the software and the date of release.
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Help Menu: MadgeTech Website
Select MadgeTech Website from the Help Menu to bring up the 
MadgeTech Website for additional information.

Note: For this feature an internet connection and browser must be enabled on 
the host computer.
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Wireless Series Devices
MadgeTech’s RF series line of wireless-enabled data loggers provides a 
simple, low-cost wireless solution for short-range data collection applications. 
These products are powered by a user-replaceable internal battery and can 
be configured for up to ten years of battery life. They are designed for one-
way, low data-rate applications, and transmit real-time data directly to a PC 
for monitoring. Like MadgeTech’s standard series of data loggers, they are 
simple to use and their versatile configuration options allow for easy integra-
tion into a wide variety of applications. The product line includes models for 
all the most popular commercial and industrial measurements, as shown in 
this table: 

 
 
 
 
 
 
 

These products have onboard memory in addition to the wireless transmitter, 
so they can completely replace existing data loggers and strip chart record-
ers while providing an added wireless data link. This memory can also serve 
as a failsafe backup, in the event of interference in the wireless channel or 
interruption of service to the monitoring computer.

Wireless: Transmitter Characteristics

The transmitter used in the RF series products is a carrier present-carrier ab-
sent (CPCA) amplitude-modulated (AM) signal operating at a carrier frequen-
cy of 418 MHz. The data being transmitted is encoded similarly to standard 
RS232 serial data at a bit rate of 4,800 baud. This signal is detected by the 
RFC101A receiver module and converted to RS232 signals, which are passed 
to the COM port of the monitoring PC.
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The transmitter type and encoding method permit the device to use the 
maximum allowable output power specified by the FCC, and also minimizes 
the amount of battery power required for the transmission. This gives the 
user the best possible range, and also ensures a long battery life. To conform 
to FCC Part 15.231 rules, the data transmission takes less than one second 
and the minimum periodic transmission rate allowed by the device is 30 
seconds. The low duty cycle permits several devices to use the same commu-
nication band and receiver without excessive interference caused by “talking 
over” each other.

Wireless: Transmission Distance
The transmission distance achievable with any wireless system is dependent 
on many factors. The only consistent measurement of transmission distance 
that can be used with these devices is called the “line-of-sight” transmission 
distance. The transmitter and receiver are set up in a large open area, free of 
obstacles and interference, and are aligned so their antennas are oriented in 
the same direction. Under these circumstances, the RF series products can 
achieve up to 120 feet (36 m) transmission range.

Wireless: System Components and Setup
The following components are required to successfully set up and use the RF 
series products: 

- A personal computer running the Windows operating system (Windows 
95 or higher)
- One of the RF series wireless-enabled data loggers
- An RFC101A wireless receiver module and power supply, for receiving 
wireless transmissions from the data logger
- An IFC110 interface cable, for communicating with the wireless data 
logger
- MadgeTech Data Recorder software, included with the RFC101A or 
IFC110

To configure the data logger, and register it on the PC for data reception, 
connect it to the PC through the IFC110 serial interface cable as shown in 
Interface Cable Installation
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To set up the system for receiving wireless data, connect the RFC101A to the 
PC and plug in the power supply to a 110VAC outlet (as shown as below). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In most cases, the IFC110 will need to be removed from the PC to con-
nect the RFC101A. If there are multiple COM ports available on the PC, 
the RFC101A may be connected to a different COM port than the IFC110, 
thus leaving IFC110 connected. To switch between using the IFC110 and 
RFC101A, simply change to the appropriate COM port under the “Commu-
nications” menu.

Wireless: Wireless Configuration Dialog
The Wireless Configuration Dialog allows the user to select from a variety of 
operating modes to meet the requirements of different monitoring systems.
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There are 2 ways To access this dialog

1. Device menu -> Identify Device and Read Status menu to open the De-
vice Status window, switch to the Device Detail tab, and click the Wireless 
Configuration button.

2. Device menu -> Start Device and click the Wireless Configuration but-
ton.

To edit the configuration, press the Change button in the dialog, make the 
appropriate changes, then press the Save button to commit the changes to 
the device.

NOTE: Closing the dialog or exiting with the OK button will not store the 
changes in the device.

To comply with FCC regulations, saving a configuration change may cause 
the device to inhibit output from the transmitter while the internal timers 
synchronize to the new configuration (this may be the longer of the reading 
interval or custom transmit interval). To force synchronization of the timers 
and enable output before the aforementioned interval has passed, restart the 
device from the software.
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Transmitter Output Modes

Real-time data transmissions may be sent through the RF antenna, the 
device’s serial port, both or neither. If both the serial and RF transmitters are 
disabled, the device will function strictly as a standard data logger. The typi-
cal user will configure the device for wireless transmission only thus transmit-
ting data from the device to the RFC101A receiver. However, serial trans-
mission may be desirable for some systems where the built-in transmitter is 
not powerful enough to maintain a reliable link, the signal must be brought 
outside of an environment that blocks RF, or when a hardwired connection 
to an alternate transmitter is required. Additionally, both modes may be 
enabled for combined local and long-distance monitoring of the signal. See 
Increasing Range with the RFExtender, page 133.

Transmitter Options

The transmitter module has four configuration options. Two of these options 
pertain to enabling and disabling the transmitter under different operat-
ing conditions and two pertain to the timing and format of the transmitted 
signal. These options are summarized below.

1. Transmit only while logging – If this option is selected, the transmitter 
will only output data when the logger is recording data to memory. When 
memory is filled and the device stops logging, the transmitter will stop as 
well to indicate the logger needs to be offloaded and restarted. If the mem-
ory wrap-around mode of the logger is enabled, the device will continue to 
overwrite the oldest internal data and continue transmitting data wirelessly. If 
this transmitter option is not selected, the transmitter will continue to oper-
ate regardless of whether the device is recording data.

2. Transmit under switch control – If this option is selected, the on/off 
switch may be used to inhibit the transmitter output. This allows the user 
to manually stop the transmitter without affecting the logger operation or 
transmission timing. This may be useful for transporting the device through 
an area where other devices are operating on the same frequency band, 
disabling the transmitter until the device is placed in-system, or disabling 
individual devices to evaluate system performance and troubleshoot interfer-
ence or collisions. In systems where a manual override is not desirable, this 
option may be left unchecked, and the transmitter will not be affected by the 
position of the switch.
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NOTE: The above two transmitter options function as such: if either one of the 
modes would disable the transmitter under given conditions, the transmitter 
will be disabled. For the transmitter to be enabled, the required conditions 
must be met for both options to allow the transmission.

3. Randomize transmit interval – If this option is selected, the transmitter 
will wait a short random delay of up to 5 seconds before it transmits each 
data packet. This can decrease the chances of lost packets due to devices 
“talking over” each other because of long-term timer drift. Devices that are 
initially synchronized to transmit 10 seconds apart can drift in their time-
keeping by up to 2 seconds per day, meaning that they could potentially 
interfere with each other after a few days of sustained operation. Because the 
transmission lasts less than a second, a random delay of up to 5 seconds can 
allow the majority of the transmissions to escape interference. If this trans-
mitter option is not selected, the device will transmit at the interval set by 
its timer to within a few milliseconds. It is then up to the user to make any 
necessary accommodations for the timer drift. See Using Multiple Devices 
later in this manual.

4. Use error correction – If this option is selected, the transmitter output 
format will be modified to include a simple forward error correction scheme 
known as a Hamming code. This method of error correction allows the re-
ceiver in a one-way transmission to correct any single bit error in each block 
of eight data bits being received. This option may help to increase system 
reliability in some environments.

NOTE: System reliability will most commonly be degraded by loss of signal or 
by burst noise longer than a single bit, thus this option may not substantially 
improve performance for the typical user. Additionally, if this option is not 
selected, the device may be able to transmit two complete copies of the data 
packet, increasing the likelihood that one of the copies will be received even 
when the other is lost due to interference. (Each packet always contains error 
detection, to ensure that invalid data is not displayed.)
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Custom Transmit Interval

By default, the transmitter module will transmit a data packet with each 
internally recorded data point, or if it is not recording, at the reading rate 
specified for the data logger. This option allows the user to specify a cus-
tom transmit interval that will be used only by the transmitter. Like the data 
logger reading rate, this interval is limited to a minimum of 30 seconds and 
a maximum of 12 hours, but unlike the reading rate it may be set to any 
multiple of 10 seconds. Additionally, the device can be configured to return 
new data every interval, or to repeatedly send the data from the most recent 
internally recorded reading. This option can be useful for the following rea-
sons:

1. Real-time monitoring – Some applications may require relatively quick 
feedback of trend data to the user, but only need to be recorded at longer 
intervals. With this option, for example, an operator could check the trend 
of a system every 10 minutes and make necessary adjustments to keep the 
system within specifications, but the official logger record of the data only 
needs to indicate the value on an hourly basis.

2. Increasing system reliability – In applications where the operating envi-
ronment is unfriendly to RF, this option can be used to repeat the same data 
multiple times to increase the probability of successful reception. If the log-
ger is recording every 5 minutes, the transmitter can be configured to send 
the data from the last reading every 30 seconds, allowing for 10 transmis-
sions per logger reading. If the environment sees a burst of RF interference 
a few times per minute, it is highly probable that one or more transmissions 
will be received properly.

3. Staggering transmissions from multiple devices – If several devices 
need to record data at the same time while transmitting the output in real 
time, this option can be used to ensure that at least one transmission from 
each device is sent without interference from the other devices. This is 
similar to the randomization option provided above, but is better suited to 
some applications. See “Using Multiple Devices” later in this manual. In the 
screenshot below, this particular wireless data logger is set to “delay start” at 
1:00PM; since the sample interval is 30 seconds, the next data logger should 
be started at 1:00:30, and the next logger should be started at 1:01:00, and 
so on.
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To prevent confusion, it’s helpful to set a delay start time for the first logger 
that is on the hour, half hour, quarter hour, 10 minutes of, and 5 minutes of. 
For example:

•  On the hour: 2:00PM, 3PM, etc.
•  On the half hour: 2:30PM, 3:30PM, etc.
•  On the quarter hour: 2:15PM, 3:15PM, etc.
•  10 minutes of: 2:50, 3:50, etc.
•  5 minutes of: 2:55, 3:55, etc.

To find the ideal delay start interval, use the following calculation:
To determine the reading rate, you must perform a simple calculation: X/
Y=Z. To solve for the ideal reading rate (Z), divide X by Y.
(Desired Reading Rate(X)) / (# Of Loggers(Y)) = Ideal delay between loggers 
(Z)

Example:
(15 minutes X 60 seconds)/25 = 36. It is best to use the closest odd number, 
so a 37 second delay start interval will be used.

NOTE: Rounding up is not encouraged because it can increase the chances of 
data overlap.

•  X= Desired reading rate (in seconds)
•  Y= # of loggers
•  Z=?

Example 1:
If X= 15 minutes, and Y= 25 loggers, then Z= 0.6 minutes X 60 seconds = 
36. In this example, 36 is rounded to an odd number, such as 37; 37 sec-
onds is the ideal delay start interval.

Example 2:
If X= 60 minutes, and Y = 75 loggers, then Z= 0.8 minutes X 60 seconds = 
48. In this example, 48 is rounded to the nearest odd number, such as 49; 
49 seconds is the ideal delay start interval.

NOTE: If Z results in < 30 seconds, change X and/or Y.
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Indicator Mode

The device may be configured to blink the LED activity indicator every 10 
seconds (the factory default setting) or only when a scheduled reading is 
taken. The green LED indicator will blink to indicate that the device is config-
ured properly to allow a wireless transmission to occur. If the wireless trans-
mitter is disabled by any of the available configuration options (by setting 
the transmitter output mode to disable the wireless output, or by selecting 
either of the related transmitter control options), the indicator will not blink. 
When a wireless transmission is about to be sent, both the green and the red 
LED indicators will blink.

The primary reason to turn off the 10-second indicator is to conserve battery 
capacity. See Battery Life, page 138. The 10-second mode is forced “on” if 
the custom transmit interval discussed above is enabled.
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Wireless: Registering the Device on a System

Before the MadgeTech software will receive data from an RF-series transmit-
ter, the device must be properly registered on the system. When the device is 
identified or configured, the PC software will store an image of the device for 
future reference. This image is stored on the PC’s hard disk so it is retained 
even when the software or PC is shut down. The software then refers to the 
device image when receiving a transmission to “fill in” the information that 
is not transmitted in the data packet. This information includes the device ID, 
calibration date, and measurement variables such as a thermocouple type or 
engineering units. The data packet contains a checksum of critical settings to 
ensure invalid data is not displayed. For this reason, the device must be re-
registered if it is calibrated or the measurement data is changed on another 
PC.

NOTE: that re-registering a device after a configuration change will not allow 
the PC to receive data from the transmitter if there is already data from the 
device in the wireless graph. If no data has been received since the software 
was launched, or the software is closed and launched again, the software will 
receive the transmissions as expected. This behavior is caused by the fact the 
data that has already been received is only valid with the previous image. 
Adding new data to the old dataset with different calibration constants or 
thermocouple type would result in invalid data.

Wireless: Starting the Device and Synchronizing the Transmitter

Like other MadgeTech data loggers, the RF series devices must be configured 
through a PC. The wireless transmitter is primarily set up through the Wire-
less Configuration dialog discussed previously, but synchronization of the 
transmitter to the desired starting time is accomplished through the Start 
Device dialog when launching the data logger. When launching, choose the 
start time, and set the logger parameters (device ID and reading rate) for 
the run. When the device is started, both the logger and transmitter time 
base will be set for the selected start time. They will remain inactive until the 
selected time, and then begin to operate as configured in the Start Device 
and Wireless Configuration dialogs. When the delay-start time arrives, the 
logger will take readings (if enabled) at the programmed reading rate, and 
wireless transmissions (if enabled) will be made at the reading rate or custom 
interval, depending on how the device is configured.
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If a delayed start is specified, the device will remain completely inactive 
during the start delay period. The indicators will not blink, no readings will 
be taken and no transmissions will be sent. It will continue to communicate 
normally, and may be queried, stopped, or restarted. If the application only 
requires the wireless transmitter without data logging capability, the device 
may be stopped immediately (when the “Transmit only while logging” op-
tion is not selected) after launching without affecting the scheduled start of 
the wireless transmissions. This will marginally improve the battery life when 
data logging capability is not required.

If immediate start is specified, the device will begin logging immediately, 
but it will inhibit transmitter output for the first reading to comply with FCC 
regulations. To ensure the first transmission is sent, use the delayed start 
mode with a 1-2 minute delay (minimum allowed by software).

Once the device is started, the wireless transmissions can be viewed by per-
forming the following steps:

1. Connect the RFC101A wireless receiver to a COM port (see Connecting 
the RFC101A wireless receiver of Wireless: System Components and Setup)

2. Go to the Communications -> Select COM Port menu and select the 
COM Port matching the port that the RFC101A is attached to (usually 
COM1)

3. Go to the Communications -> Select Baud Rate menu and select 4,800 
Baud

4. Go to the Communications menu and ensure that Accept Real Time 
Wireless Input has a check mark next to it. If it does not, click on it and go 
back to the Communications menu to confirm it is now checked.

5. Go to the Device Menu and choose Display Real Time Wireless Data

6. Wait for the first data point to be received.

7. For multiple data loggers, choose the Composite Graph tab to view all 
of the wireless data sets in one graph. This helps the speed in refreshing the 
graph and is useful when comparing data from multiple data loggers, and 
looking for data trends.

The LED’s on the RFC101A indicate power (green) and data (red). The Red 
LED light up briefly every time a new data point is received. The Green LED 
should be on steady. If not, ensure that the wall power adapter is plugged in 
properly.
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Wireless: Using Multiple Devices

When using more than one RF transmitter, should transmissions overlap, it 
is certain that one or both of the transmissions will be lost. There are several 
methods, described below in order of complexity (least to most), to circum-
vent this issue:

1. Use Delay Start to Stagger the Reading / Transmit intervals – By choos-
ing a reading rate (see below Table:Prime numbers from 3 to 2160 and 
Table:Prime number examples, or above Staggering transmissions from mul-
tiple devices under Custom Transmit Interval) and delay between start times 
on multiple loggers, you can ensure that the computer never receives more 
than one wireless signal in a 30 second window.
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2. Rely on the logged data - The RF transmitters can be configured to log 
all data to non-volatile memory. If a data point is lost, it may be fully recov-
ered by a later offload.

3. Provide a direct connection - If it is possible to have a PC always con-
nected to the RF series logger (while monitoring via RF elsewhere), then 
using the serial output transmitter mode or the real-time chart recording 
feature of the software will avoid RF interference.

4. Randomize the transmission interval – This option is selected from the 
wireless configuration menu. Selecting this option will cause the transmitter 
to wait a short random delay of up to 5 seconds before it transmits each data 
packet. Should two transmitters drift to within 5 seconds of each other, this 
feature will reduce the dropped points by about 80% until the transmitter 
clocks drift apart again. This will also decrease the chances of sequential lost 
packets.

5. Staggering of scheduled transmissions – By starting the RF transmitters 
at different times, the transmissions will not overlap until the time drift be-
tween the transmitter clocks causes transmission collisions. At room tempera-
ture, the typical clock will drift no more than 1-2 seconds per day. Higher or 
lower temperatures will cause more drift. For example: if you use delay start 
to start one transmitter at 11:00:00 and a second transmitter at 11:00:30 (at 
1 minute sample rates), then typically they would run for about 30 days (at 
similar temperatures) before there was a possibility of a collision. However, 
temperature fluctuations that deviate up or down from room temperature 
will generally cause the clock to run slower. Thus, potential collisions depend 
the time between samples, relative clock accuracy and relative ambient tem-
peratures.

6. Prime number scheduled transmissions – This method utilizes prime 
numbers to help prevent transmission collisions. See the next section for 
further detail on this method.

Wireless: Preventing Collisions with Prime Numbers

As mentioned in the previous section, prime numbers can be helpful in 
preventing collisions, allowing the maximum amount of data to be received 
from every transmitter. This section will outline the steps to follow to select 
the best transmission intervals, and provide a worked example.
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Using prime numbers is advantageous because the common multiples of 
two prime numbers are farther apart than the multiples of two nearby non-
primes. (For example, the numbers 8 and 12 have a common multiple at 24, 
48, 72, etc., while 7 and 11 have their first common multiple at 77.) So, if 
two transmitters were set up to transmit at 8 and 12 minutes respectively, a 
collision (and a lost transmission) would occur every 24 minutes, much more 
often than if they were set up to transmit at 7 and 11 minutes. When ex-
panding to 3 or more transmitters, this property is even more pronounced.

The size of the prime number matters as well. For larger prime numbers, 
fewer collisions will occur in a given amount of time.

Finally, to minimize the impact of the collisions that do occur, the transmitter 
should be configured to transmit the same data at least twice for every read-
ing. This can be accomplished using the “Return most recently recorded data 
only” option in the Wireless Configuration dialog. For two transmitter sys-
tems, this ensures that every reading will have at least one clear window for 
transmission. If two transmitters collide during the first transmission attempt, 
they cannot possibly collide during the second (they are scheduled to select 
different windows for the second attempt). For three or more transmitters, it 
is possible to collide with one transmitter on the first attempt and another on 
the second attempt, but the number of these “sequential collisions” is very 
small.

The general procedure for selecting transmission intervals follows below. It 
assumes that all the transmitters will be recording data at the same rate.

1. Determine the number of transmitters – Determine the number of 
points that need to be monitored, and select the transmitters that will cover 
those points most efficiently.

2. Determine the reading interval – The reading interval selected for the 
devices should be the longest interval that will provide the data needed for 
the application.

3. Select the prime numbers – The transmission intervals must always be 
a multiple of 10 seconds. So, divide the reading interval (in seconds) by 20, 
and pick the largest prime numbers that are less than this value. This ensures 
that there will always be at least two transmission slots per reading for each 
transmitter. Prime numbers in the necessary range are listed in Table 1 below.
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4. Assign the transmission intervals – Multiply the prime numbers selected in 
step 3 by 10, and assign them to the transmitters. If some transmitters are 
monitoring more critical data than others, they may be assigned the smaller 
or larger numbers depending on the application. If the smallest numbers 
are substantially less than half the reading interval (e.g. 130 seconds for a 
10 minute reading interval), assign them to the more critical transmitters to 
increase the number of transmissions per reading. If the smaller numbers are 
close to half the reading interval, assign the larger numbers to the critical 
transmitters, as the larger numbers will experience slightly fewer collisions.

5. Configure and launch the devices – In the Wireless Configuration dialog, 
enable the custom transmit interval, and select the Return most recently 
recorded data only option for each device. Enter the proper transmission 
interval in seconds (be careful not to enter the number incorrectly as hours/
minutes/seconds), and save the configuration before exiting the dialog. 
When launching the devices, use delayed start mode to begin the transmis-
sion schedules at the same time, and select the reading interval determined 
in step 2.
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Table: Prime numbers from 3 to 2160 
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Prime Number Examples
Two examples are provided in “Table:Prime number examples” below to il-
lustrate the procedure. Notice that increasing the reading interval by a factor 
of 6 (1 hour instead of 10 minutes) results in an increase by a factor of 540 in 
the time before data is lost (45 days instead of 2 hours)!   
Table: Prime number examples

Wireless: Autosave of Wireless Data

A convenient feature of the Wireless Real Time Chart Recording mode of 
the MadgeTech software is the ability to automatically save the data to all 
supported data file formats such as (.CSV files); software version 2.00.70 or 
higher is required. Data can also be saved manually using File/Save As in the 
software or the Save As button in the Configure Wireless Data dialog. 

Note. While the Auto Save feature is enabled, system memory consumption 
will go up. To avoid excessive PC memory consumption, MadgeTech recom-
mends setting the amount of readings that are saved to the highest value 
(e.g. every 1000 Readings) that is possible. For operations with 1-2 data 
loggers, it is OK to set “200” as the reading count. To select where a file is 
automatically saved/archived to, simply click the Browse button and specify 
a directory where the files will be automatically saved. Note. Initially, the 
default directory is the same as that set in your software preferences under 
the Data tab. To setup the autosave feature, ensure your wireless data logger 
has been started by using a standard interface cable, and that the RFC101A 
wireless receiver is now attached to the target PC. Precisely, follow the steps:

1. Start the logger as in the section Starting the Device and Synchronizing 
the Transmitter

2. Under the Communications menu, ensure that Accept Real Time Wire-
less Input is checked.

3. Choose the Composite Graph tab to view all of the wireless data set.

4. Click Device Menu and note the following menu additions/changes per-
taining to wireless transmissions:

- Configure Wireless Data

- Wireless Statistics

- Wireless Alarm Setup

5. Click Device menu then Configure Wireless Data. The Configure Wireless 
Data window below will appear and list the loggers whose wireless data have 
been received.
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6. The following checkboxes are:

Accept Data From Device – allows the user to set whether the software ac-
cepts wireless data from each device in the list. This is useful if it is necessary 
to isolate data reception to certain transmitters in certain locations.

Display Data on Wireless Graph – allows the user to set whether the soft-
ware displays wireless data from each device in the list. This is useful if it is 
desirable to only view data from certain devices.

Automatically Save Data – allows the user to set whether the software will 
automatically save data from each device in the list. This is useful if you want 
to archive data from some devices, but not all of them.

Browse button - allows the user to program the directory where saved data 
is archived.

The Readings drop down menu - allows users to program the data to auto-
matically save after a certain amount of data has been received.
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7. Careful use of Autosave – It is recommended that Manual save be used 
in most cases. If Autosave of wireless data is needed for record keeping 
purposes, use a longer autosave interval as the number of received data 
loggers increases. Autosave interval is set as default at every 500 readings. 
When using 1-2 loggers, 200 reading interval will be OK; while when using 
10 loggers, 1000 reading interval is recommended. Autosave feature will be 
improved when MadgeTech implements XML file format for autosave in the 
future release.

Wireless: Real Time Wireless Alarming

This feature is useful when alarm notifications (screen, email, cell phone 
text message) are critical. To set up real time wireless alarming, ensure the 
transmitter(s) in use have been started and the RFC101A receiver is installed 
on the system and has been configured properly (e.g. change baud rate to 
4800). To access the real time wireless alarming functions, follow these steps:

1. Start the logger as in the section Starting the Device and Synchronizing 
the Transmitter
2. Ensure that Display Real Time Wireless Data from the Device menu is 
selected.
3. Choose the Composite Graph tab to view all of the wireless data set.
4. Click Device then Wireless Alarm Setup.
5. The Wireless Alarm Setup window below will appear and list the loggers 
whose wireless data have been received.
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6. Highlight an RF data logger and click the button Create New or Modify. 
A Wireless Alarm Settings window will appear. The Serial Number and 
Device Name (ID) will be listed.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Ensure that Notification and Channel tab is selected. There are two noti-
fication types:

Screen Alarm – will notify the user with a window indicating an alarm has 
been activated.

Email Alarm – will notify the user with an email or cell phone text message 
that an alarm has been activated. If you check the Email Alarm checkbox 
then please remember to go to Email tab to enter the required information.
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NOTE: For email notification, please contact your IT Department for infor-
mation on your mail server/network settings. For cell phone text messaging, 
please contact your cell phone company to activate your cellular phone to 
receive emails in the form of text message alarms. The feature to mention to 
the cellular phone company’s is “SMS messaging to email”, or email to cel-
lular text message function. In order to use the cellular phone text messaging 
option, this must be completed.
For convenience, MadgeTech is providing this web site for customers to look 
up the section titled “Email to SMS / Web to SMS”:
http://en.wikipedia.org/wiki/SMS_gateways
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Notify on every reading out of range – will notify the user at the pro-
grammed sample interval when an alarm condition has occurred.

Notify only on initial out of range reading – will notify the user as soon 
as the first alarm condition occurred, but will not continue to alert the user 
thereafter.

Notify on every [H] [M] [S] while reading is out of range – will notify the 
user after a specified length of time that an alarm condition has occurred. 
This is useful if a parameter is allowed to stay in an alarm condition for a 
certain amount of time, and if the alarm continues, it is of concern to be 
alerted.

Channel Settings – Allows the user to set the channel in which they want an 
alarm to be associated with. The user can also specify the respective units for 
the measurement channel.

Low Alarm – allows the user to specify that if a value measured is lower 
than what the user specified, then either a screen and/or email/text message 
alarm will appear.

High Alarm - allows the user to specify that if a value measured is higher 
than what the user specified, then either a screen and/or email/text message 
alarm will appear.

Add/Modify – allows the user to add the created alarm to the alarm list. To 
save the alarm settings, click OK to save the settings and close the Wireless 
Alarm Settings window.

In the Wireless Alarm Setup window the data grid will show the added 
alarms. Click the Save and Exit button to save the settings and close the 
Wireless Alarm Setup window. If the user clicks the Cancel button, the win-
dow will close without saving settings/changes.
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In the Wireless Alarm Setup window, highlight an alarm in the data grid 
and this will enable the Delete button. Use the Delete button to delete an 
alarm. Click the Save and Exit button to save the changes or click Cancel to 
ignore the changes.

In Wireless Alarm Setup window, if there are entries in the data grid, then 
the feature Notifying no reading received for a period of TIME will be en-
abled. This feature allows the user to be notified if no wireless data has been 
received for a period of TIME either in terms of Screen Alarm or Email Alarm 
(as checked in the Wireless Alarm Settings window).

The Save Setup to File button will become enabled when there is one or 
more alarm set up and shown in the grid. Click Save Setup to File and enter 
a file name to save all the alarms in the grid to the XML file.
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If the device to be set up for wireless alarming is listed then their previous 
saved alarm setup can be loaded. Click Load Alarm Setup button and select 
the XML file to load.
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Click OK button. If this file contains alarm setup for the active devices shown 
on the list then a message will show up to confirm. 

 
 
 
 
 
 

Wireless alarm notification will appear like below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Wireless: Increasing Range with the RFExtender

The RFExtender products can extend the transmission distance of 
MadgeTech’s RF series products for up to 1 mile (1.6 km) under ideal condi-
tions. Typical ranges are 1000 to 2000 feet (300 to 600 m) outdoors, and 
up to 300 feet (100 m) indoors. An RFExtender system requires a minimum 
of two RFExtender transceivers, one at each node of the wireless link. The 
RFExtender transceivers require AC power.

Simple RFExtender System

A basic set-up might be one of the two configurations below:
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1. RFExtender as a wireless repeater

 
 
 
 
 
 
 
 
 
 
 
 

2. RFExtender as a wireless communication interface

 
 
 
 
 
 
 
 
 
 
 

In either configuration, the RFExtender functions like an extension cable 
between the logger interface and the PC. The primary difference between 
the two setups is the logger interface that is connected to the RFExtender. 
Figure (RFExtender as a wireless repeater) uses an RFC101A, and is therefore 
limited by the one-way communication between the RF data logger and 
the RFC101A. Just like using the RFC101A by itself, this setup requires that 
the logger be brought back to the PC and connected to an IFC110 interface 
cable to launch, download, or configure the logger. Figure (RFExtender as a 
wireless communication interface) allows two-way communication through 
the IFC110 and thus can allow full use of the data logger features.
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The setup in Figure (RFExtender as a wireless repeater) is necessary when 
several transmitters must send their data to the same RFExtender. The data 
is received by the RFC101A, and retransmitted or “repeated” to the PC. 
Figure(RFExtender as a wireless communication interface) is appropriate 
when only one data logger needs to be used with a particular RFExtender, at 
a particular time. The data logger is configured to transmit data packets over 
the serial cable instead of through the wireless transmitter, and the RFExtend-
er transmits the serial data back to the PC. This setup has two advantages: 
the logger can be launched, downloaded, and configured without bringing 
it back to the PC, and the IFC110 interface cable is less expensive than the 
RFC101A.

Complex RFExtender System

It is possible to use more than two RFExtenders in a system with more than 
two nodes. This type of setup will be an extension of the two simple setups 
demonstrated above. Refer to Figure(RFExtender as a wireless communica-
tion interface) for an example of a complex system.

The Figure on page 137 (A complex RFExtender system) shows an RFExtend-
er connected to a PC that can receive data from 8 other transceivers. Each 
of the remote transceivers can either communicate serially with one logger 
via an IFC110 or receive wireless data from multiple RF series transmitters 
through an RFC101A. For this system to function properly, each transceiver 
must be set up to receive data only from the proper location. This is accom-
plished by assigning each transceiver a unique module address to identify 
itself, and a receiver address mask to identify the module addresses from 
which it will receive data.

Module Address and Receiver Address Mask

The module address provides a unique identification of the individual trans-
ceivers. It consists of 4 hexadecimal digits, which can be divided between a 
“system number” and a node address within that system. Most applications 
will us a module address of the format XXYY, where XX is the system num-
ber and YY is the node address. A system is comprised of a PC connected to 
an RFExtender transceiver (the “Local Node”) and several other transceivers 
(“Remote Nodes”) setup within the transmission range. Using the system 
number is not strictly necessary, but it allows several groups of transceivers to 
be located within transmission distance of each other without allowing data 
from one group to be received by the other.



Page 136

MadgeTech Operating Manual

The receiver address mask is also 4 digits and will usually be configured in 
one of two ways: to receive data from all the modules within a system, or to 
receive data only from another module with the same module address. Only 
the local node at the PC will be configured to receive data from multiple 
modules, as only the PC is capable of receiving and processing the data be-
ing transmitted by all the modules. The remote nodes will be assigned indi-
vidual addresses, and configured only to accept transmissions from a module 
with the same address as their own. To allow two-way communication with a 
remote node, the local node module address and receiver address mask will 
be changed temporarily to match that of the remote node.

Assigning module addresses should begin with the determination of the 
system number. The system numbers used may be sequential, starting with 
one, as the zero address has special significance. The local node should be 
assigned node address zero, and the remote nodes may be sequential start-
ing with one. Note that this is how the module addresses in Figure(A com-
plex RFExtender system) below were generated.

The receiver address mask instructs the transceiver which data to receive by 
indicating what part of the incoming module address should be compared 
to its own module address. The remote nodes should be assigned receiver 
address masks of “FFFF”. In general terms, a hexadecimal digit “F” in the re-
ceiver address mask means “compare this digit”. So a receiver address mask 
of “FFFF” means “compare all the digits”, and if all the digits do not match, 
ignore the incoming data. In technical terms, the comparison is performed 
as a logical “AND” operation, which is a common function in computers and 
digital circuits.

Receiver Address Mask Example

The local node in Figure (RFExtender as a wireless communication interface) 
has a module address of “0100” and a receiver address mask of “FF00”. Sup-
pose that it receives data from module address “0104”. The incoming ad-
dress is processed through the mask as “0104” AND “FF00” = “0100”. The 
result matches the local node address of “0100”, so the transceiver passes 
the data through.

Likewise, suppose that module address “0104” receives data from module 
address “0108”. The incoming address is processed through the mask as 
“0108” AND “FFFF” = “0108”. The result does not match the receiver’s 
module address of “0104”, so the receiver ignores the data.
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For further information on uses of the module address and receiver address 
mask, contact MadgeTech Technical Support.

A complex RFExtender system
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Wireless: Battery Life

There are many variables that affect the battery lifetime. These variables 
include (but are not limited to) sample rate, transmit rate, LED settings, 
transmission settings, ambient temperature and battery self-discharge.

For the purposes of approximating battery life, please consult Tables 3 and 4 
below. These numbers should not be used as an absolute guarantee, but as 
an approximate guide for deciding when the battery will need replacement. 
This table is useful because the lithium batteries used in the RF products 
do not show a strong correlation between voltage and remaining capacity, 
which makes it very difficult to measure their remaining life. In lithium bat-
teries, the voltage stays very nearly constant for the entire life of the battery 
until it drops sharply and suddenly when depleted.

There are variables that it is not possible to account for in the tables. The 
table assumes a pattern of continuous use, in which both the logger and 
transmitter features are used such that both the transmitter and logger are 
active at approximately the indicated “activity rate” (for cases where the log-
ger and transmitter operate at different rates, use the faster rate for estima-
tion). The calculations assume that the device is configured and deployed, 
then downloaded and redeployed when the logger is nearly full.

Table: Estimated battery life

 
 
 
 
 
 
 
 
 
 
 

The transmitter settings used to calculate the best, worst and factory default 
cases are indicated in Table:Transmitter settings for battery life estimation.
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Table: Transmitter settings for battery life estimation 
 
 
 
 
 
 
 
 

Even longer battery life can be achieved by disabling the wireless output in 
favor of serial-only or no transmission. Battery life is not calculated for these 
unusual cases.

Wireless: Operating Environment

The RF series data loggers are rated for –30 to +70 °C (-5 to +50 °C for the 
RFpHTemp101A) and up to 95 %RH (non-condensing). Although the devices 
are fully functional over this range, the strength of the wireless output signal 
may vary with changes in environment. In particular, the signal strength may 
be reduced at the temperature extremes, in high humidity, or if humidity 
condenses inside the device.

Wireless: System Performance and Reliability

To achieve maximum distance for the wireless transmission, there are a 
number of guidelines that should be followed. Consider these points when 
setting up the system:

Transmitter location - Keep the transmitter as close to the receiver as pos-
sible. If either the transmitter or receiver must be in an enclosed area, keep 
the other inside the same area. This is especially important if there would be 
metal walls, conduit, or wires between the units. In particular, attempting to 
transmit from inside of a freezer or refrigerator is not likely to be successful.

Line of sight - Keep the transmitting and receiving antennas along a direct 
line of sight from one to the other. In addition, keep the number of corners 
or obstacles in between them to a minimum.
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Nearby objects - Try to keep the transmitting and receiving antennas away 
from any foreign objects, especially those made of metal. Performance may 
be improved by moving the antenna away from the ground, ceiling, or 
nearby objects.

Antenna orientation - Keeping the transmitting and receiving antennae 
parallel with one another may improve performance. 

Composite Graph - Keep the Wireless Realtime Chart Recording selected on 
the Composite Graph tab when receiving readings from multiple recorders.

Minimize interference - Keep external sources of radio frequency noise to 
a minimum. Locate the antenna and receiver as far from any other electrical 
or wireless devices as possible. If multiple transmitters are being used, set up 
the system to minimize interference between transmitters.

Minimum delay between readings - Keep the transmit intervals to no less 
than 30 seconds between readings on ALL devices. This can be accomplished 
using the Delay Start method and specifying start times at least 30 seconds 
apart from each other, and a reading rate that will not result in overlapping 
transmissions.

Recommended Maximum number of transmitters per system - See Table:
Maximum Recommended transmitters per system for recommendations 
based on reading rate used.

Careful use of Autosave - It is recommended that Manual save be used in 
most cases. If Autosave of wireless data is needed for record keeping pur-
poses, use a longer autosave interval as the number of received data loggers 
increases. Autosave interval is set as default at every 200 readings. When 
using 1-3 loggers, 200 reading interval will be OK; while when using 10 
loggers, 1000 reading interval is recommended. Autosave feature will be 
improved when MadgeTech implements XML file format for autosave in the 
future release.
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Table: Maximum Recommended transmitters per system

Computer Specifications and Maintenance - As with any software ap-
plication, a newer model computer with a fast CPU and plenty of available 
memory is a key factor in achieving the best performance. A windows disk 
cleanup such as Disk Defragmenter and Scandisk will help improve system 
performance greatly. System reliability can also be improved using the File 
then Save command to archive wireless data every x amount of readings. For 
example, reliability will be increased if data is being archived every 200 read-
ings, than if it was being archived ever 2000 readings.

Periodically Restart the MadgeTech Software - For long-term wireless 
reception of multiple RF-series data loggers, MadgeTech recommends that 
the data be manually saved and the software restarted as often as every few 
days, depending on how often new data is received. Memory usage of the 
MadgeTech2.exe program can be tracked in the Processes tab of the Win-
dows Task Manager. When a wireless data logger is configured and launched 
at the target PC, a unique *.DVC (device file) is stored in the MadgeTech 
program directory. This *.DVC file contains information about the wireless 
transmitter, which can be loaded on to other PC’s so those computers can 
accept real time wireless data. Of course it is necessary that the PC on which 
the DVC file was loaded is setup with an RFC101A receiver, the baud rate 
is 4800, Accept Real Time Wireless Input is selected from the Communi-
cations menu, and Display Real Time Wireless Data is selected from the 
Device menu.
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Wireless: FCC Compliance and Requirements

MadgeTech’s RF series products operate in an “unlicensed” operation band, 
meaning the end-user does not need to do anything special (such as obtain 
a license) to legally make use of the product. MadgeTech has performed all 
the required testing and certification to ensure that these products meet the 
requirements for unlicensed operation outlined in 47 CFR Part 15.231 of the 
FCC rules. However, the user must understand and adhere to the following 
notes and guidelines:

Any user changes or modifications that are not expressly approved by 
MadgeTech, Inc. may void the user’s authority to operate the device per 
FCC code, section 15.231. 

Wireless: Federal Communications Commission (FCC) Notice

The following FCC IDs are associated with the devices covered by this 
manual:         
The following statement applies to all of the devices covered in this manual:

This device complies with Part 15 of the FCC Rules. Operation is subject 
to the following two conditions: (1) this device may not cause harmful 
interference and (2) this device must accept any interference received, 
including interference that may cause undesired operation.

NOTE: This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses and can radi-
ate radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or tele-
vision reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one of more of 
the following measures:
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•  Reorient or relocate the receiving antenna.
•  Increase the separation between the equipment and receiver.
•  Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected.
•  Consult the dealer or an experienced radio/TV technician for help.

Wireless: Industry Canada (IC) Notice

The following IC identification numbers are associated with the devices 
covered by this manual. These certifications/registrant numbers are displayed 
on the labels of the products. Removal or defacement of these numbers will 
void the IC certification. 
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Contact Information
For further information described in this manual, please contact:

MadgeTech, Inc.
P.O. Box 50 
Warner, NH 03278

Phone: (603) 456-2011
Fax: (603) 456-2012
Email: support@madgetech.com
Web: http://www.madgetech.com/
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Terms and Conditions
All products furnished by MadgeTech, Inc. (“Seller”) shall be in accordance with the following terms 
and conditions unless otherwise stated in writing: 

These Terms and Conditions (“Terms and Conditions”) govern (a) all sales quotations and sales 
of components, equipment, parts, and other products (“Product”) from, and (b) all service proposals 
and provisions of services by Seller to the buyer of the Products (“Buyer”). These Terms and Conditions 
shall take precedence over any terms and conditions which appear on Buyer’s order or other form or 
any other writing or electronic transmission from Buyer. Any terms or conditions on any of Buyer’s 
forms, recordings, electronic transmissions, or orders that are different from or in addition to these 
Terms and Conditions are specifically rejected. Any modification to these Terms and Conditions must 
be agreed to and executed in writing by Seller. Seller’s failure to object to provisions contained in any 
communication from Buyer shall not be construed as a waiver of these Terms and Conditions or as an 
acceptance of any such provision. Trade custom, trade usage and past performance are superseded by 
these terms and conditions and shall not be used to interpret these terms and conditions. In the event 
that Product includes software, the software is licensed to Buyer in object code form only in accor-
dance with Seller’s standard Software License Terms that are included below.

Limited Warranty.
A. Seller Manufactured Products and Seller Provided Services. 

Seller warrants to Buyer that:

(i) Seller manufactured Software (as defined in Section 23 below) shall execute the programming 
instructions provided by Seller, and

(ii) Seller manufactured Product and consumables and Seller provided services shall be free from 
material defects in material and workmanship under normal uses and care, in each case until 
the expiration of the applicable warranty period specified below

Seller manufactured Product is warranted for the shorter of twelve (12) months from the date 
of initial installation or fifteen (15) months from the date of shipment by Seller. Seller manufactured 
consumables and Software, and Seller provided services are warranted for a period of ninety (90) 
days from the date of shipment or completion, as applicable. If Buyer discovers any warranty defect 
and notifies Seller thereof in writing during the applicable warranty period, Seller shall, at its option, 
promptly correct any defects that are found by Seller, or repair or replace F.O.B. point of manufacture 
that portion of the Seller manufactured Products, consumables or Software found by Seller to be 
defective, or refund the price of the defective portion of the Seller manufactured Products, consum-
ables or Software, or of the defective portion of the Seller provided services. All replacements or repairs 
necessitated by inadequate maintenance, normal wear and usage, unsuitable power sources, unsuit-
able environmental conditions, accident, misuse, improper installation, modification, repair, storage or 
handling, or any other cause not the fault of Seller are not covered by this limited warranty, and shall 
be at Buyer’s expense. Seller shall not be obligated to pay any costs or charges incurred by Buyer or 
any other party except as may be agreed upon in writing in advance by an authorized representative 
of Seller. All costs of dismantling, re-installation and freight, and the time and expenses of Seller’s per-
sonnel for site travel and diagnosis under this limited warranty shall be borne by Buyer unless accepted 
in writing by Seller. Seller manufactured Products, consumables and Software, and Seller provided 
services, repaired, replaced or corrected during the applicable warranty period shall be in warranty for 
the greater of the remainder of the applicable original warranty period or ninety (90) days.

THE FOREGOING STATES THE SOLE AND EXCLUSIVE WARRANTY AND LIABILITY OF SELLER. 
FOR BREACH OF WARRANTY AND IS IN LIEU OF ALL OTHER REPRESENTATIONS, WARRANTIES AND 
COVENANTS, EXPRESSED OR IMPLIED, IN REGARD THERETO. EXCEPT FOR THE EXPRESS LIMITED 
WARRANTY SET FORTH IN THIS SECTION, SELLER DOES NOT MAKE AND HEREBY DISCLAIMS ANY 
AND ALL OTHER REPRESENTATIONS AND WARRANTIES OF ANY KIND WHATSOEVER, WHETHER EX-
PRESSED, IMPLIED OR STATUTORY, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT OR ACCURACY, 
ADEQUACY OR COMPLETENESS OF DATA MEASUREMENT, WITH RESPECT TO ANY OF THE SELLER 
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MANUFACTURED PRODUCTS, CONSUMABLES OR SOFTWARE, OR ANY OF THE SELLER PROVIDED 
SERVICES.

Any drawings submitted with the Products are only to show the general style, arrangement, and 
approximate dimensions of the Products.

B. Equipment, Consumables, Software and Services Manufactured or Provided by Others.

SELLER DOES NOT MAKE, AND HEREBY DISCLAIMS, ANY AND ALL REPRESENTATIONS AND WAR-
RANTIES OF ANY KIND WHATSOEVER, WHETHER EXPRESSED, IMPLIED OR STATUTORY, INCLUDING, 
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY PARTICULAR PURPOSE, 
NONINFRINGEMENT OR ACCURACY, ADEQUACY OR COMPLETENESS OF DATA MEASUREMENT, 
WITH RESPECT TO ANY EQUIPMENT, COMPONENTS, PARTS, CONSUMABLES, SOFTWARE OR SER-
VICES SOLD TO BUYER BY SELLER THAT ARE NOT MANUFACTURED OR PROVIDED BY SELLER. Seller 
shall assign the manufacturer’s or service provider’s warranty applicable to such equipment, compo-
nents, parts, consumables, Software and services to the extent permitted, to Buyer. Seller will provide 
Buyer with available warranty information.

Limitations. 
IN NO EVENT, REGARDLESS OF THE FORM OF THE CLAIM OR CAUSE OF ACTION (WHETHER BASED 

IN CONTRACT, INFRINGEMENT, NEGLIGENCE, STRICT LIABILITY, OTHER TORT OR OTHERWISE), SHALL 
SELLER’S LIABILITY EXCEED THE PRICE ACTUALLY PAID BY BUYER TO SELLER FOR THE SPECIFIC PROD-
UCTS, CONSUMABLES AND/OR SOFTWARE MANUFACTURED, AND/OR SERVICES PROVIDED, BY SELLER 
GIVING RISE TO THE CLAIM OR CAUSE OF ACTION. SELLER SHALL NOT, UNDER ANY CIRCUMSTANCES, 
BE LIABLE FOR ANY LOSS OF REVENUE, LOSS OF PROFITS OR ANY INCIDENTAL, INDIRECT, SPECIAL, 
EXEMPLARY OR CONSEQUENTIAL DAMAGES, WHETHER OR NOT FORESEEABLE. NO ACTION, REGARD-
LESS OF FORM, ARISING OUT OF ANY TRANSACTION GOVERNED BY THESE TERMS AND CONDITIONS, 
MAY BE BROUGHT BY EITHER PARTY MORE THAN TWO (2) YEARS AFTER THE CAUSE OF ACTION HAS 
ACCRUED. The foregoing allocation of risk and limitation of liability has been agreed to by the parties and 
forms the basis of their willingness to enter into any accepted order.

Software License. 
(A) For purposes hereof, “Software” means the computer programs included in the Product at 

delivery, together with all codes, techniques, software tools, formats, designs, concepts, methods, and 
ideas associated with those computer programs. The term also includes all copies of any part of the 
software, as well as the manual(s) and printed materials provided by Seller.

(B) Seller grants Buyer a non- exclusive, non-transferable license to use the Software, in object 
code form only, according to the terms set forth below. Buyer may operate the Software only (i) in 
conjunction with and as part of the Product; (ii) in the manner in which it is intended by Seller; and 
(iii) at Buyer’s plant site where the Product is first used. Buyer may negotiate with Seller separate 
licenses to use the Software at other plant sites. Buyer’s use of Software shall be governed exclusively 
by Seller’s and/or an third party owner’s applicable license terms.

(C) Buyer shall not (i) make the Software available to any person or entity other than its employ-
ees, who must use the Software only as specified above; (ii) modify the Software or merge it with 
another program; (iii) reverse engineer, disassemble, decompile, or make any attempt to discover 
the source code of the Software; (iv) translate or create derivative works based on the Software; (v) 
remove, obscure, or alter any notice of the patent, copyright, or other proprietary rights related to the 
Software; (vi) sub-license, sell, lend, rent, or lease any portion of the Software; (vii) copy any portion 
of the Software; (viii) operate the Software other than in conjunction with operation of Product; or (ix) 
transfer the Software in violation of applicable United States Export laws and regulations.

(D) The Software involves valuable proprietary rights to Seller and others. There is no transfer to 
Buyer of any title to or any ownership of the Software or any patent, copyright, trade secret, trade 
name, trademark, and other proprietary rights related to the Software, regardless of the form in which 
they exist. Seller may at any time replace, modify, alter, improve, enhance, or change the Software.
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© 2008 Madgetech, Inc. All rights reserved.

(E) Both the license and Buyer’s right to use the Software terminate automatically if Buyer violates 
any of these Terms and Conditions. In the event of termination, Buyer must immediately return, or 
destroy, all copies of the Software.     
Note: For full details on Terms & Conditions, go online to www.MadgeTech.com.
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